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[bookmark: _Toc422471311][bookmark: _Toc52867941][bookmark: _Toc92092209][bookmark: _Toc421025597][bookmark: _Toc422471143][bookmark: _Toc463463924]Introduction
[bookmark: _Toc409688291][bookmark: _Toc409689134][bookmark: _Toc409689198][bookmark: _Toc409695785][bookmark: _Toc409695857]The Event Capture Graphical User Interface (GUI) User Manual provides instructions for using the Event Capture options within the GUI setting. The target audience for this manual includes Event Capture managers, application coordinators (ADPACs) and other software users.
The GUI provides a consistent, event-driven, Windows® style user interface for Event Capture.
The Event Capture software provides a mechanism to track and account for procedures and delivered services that other Veterans Health Information Systems and Technology Architecture (VistA) packages do not handle. The procedures and services tracked through Event Capture are associated with the following:
The patient to whom they were delivered
The provider requesting the service or procedure
The DSS Unit responsible for delivering the service
DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical center. Veterans Affairs Medical Centers (VAMCs) define the DSS Units. A DSS Unit can represent any of the following:
An entire service
A section of a service
A small section within a section
A medical equipment item used in patient procedures
The user must define the following items for every DSS Unit:
Service: The service associated with the DSS Unit
Cost Center: The fiscal identifier for the service using the particular DSS Unit (Cost Centers are defined in detail in the MP4-Part V Appendix B of the Fiscal Service Cost Manuals)
Medical Specialty: The specialty section associated with the DSS Unit
[bookmark: _Toc463463925]Purpose
The Event Capture GUI User Manual is intended for use as an instructional guide to using the Event Capture software. The user can use this manual in conjunction with the Event Capture GUI online help option.
Screen displays may vary among different sites, and the data may not appear on the terminal exactly as shown in this manual. Although screens are subject to modification, the major menu options as they appear in this manual are fixed and are not subject to modification (except by the package developer).
[bookmark: _Toc463463926]Document Orientation
[bookmark: _Toc463463927]Organization of the Manual
[bookmark: _Toc463463928]Assumptions
This guide was written with the following assumed experience/skills of the audience:
User has basic knowledge of the operating system (such as the use of commands, menu options, and navigation tools).
User has been provided the appropriate active roles, menus, and security keys required for the Event Capture System (ECS).
User is using ECS to do their job.
User has validated access to ECS.
User has completed any prerequisite training.
[bookmark: _Toc463463929]Disclaimers
The following disclaimers apply to all Department of Veterans Affairs (VA) user documentation.
[bookmark: _Toc463463930]Software Disclaimer
This software was developed at the VA by employees of the Federal Government in the course of their official duties. Pursuant to title 17 Section 105 of the United States Code, this software is not subject to copyright protection and is in the public domain. VA assumes no responsibility whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its quality, reliability, or any other characteristic. We would appreciate acknowledgement if the software is used. This software can be redistributed and/or modified freely provided that any derivative works bear some notice that they are derived from it, and any modified versions bear some notice that they have been modified.
[bookmark: _Toc463463931]Documentation Disclaimer
The appearance of external hyperlink references in this manual does not constitute endorsement by the VA of this website or the information, products, or services contained therein. The VA does not exercise any editorial control over the information you may find at these locations. Such links are provided and are consistent with the stated purpose of the VA.
[bookmark: _Toc463463932]Documentation Conventions
To avoid displaying sensitive information regarding our patients and staff, the examples in this manual contain pseudonyms or scrambled data instead of real names. Our patients and staff will be referred to as “ECPATIENT, ONE”, “AAECPROVIDER, ONE”, or “USER, ONE.” Scrambled data are a series of random letters that replace a real name like “AAADY, JWHTRE”. Likewise, real social security numbers (SSNs), real addresses, and other personal identifiers are not used.
[bookmark: _Toc463463933]References and Resources
The documentation for Event Capture v2.0 includes the following related manuals:
Event Capture Installation Guide
Event Capture Patch Description
Event Capture Technical Manual
Event Capture GUI Release Notes
These documents can be found at on the VA Documentation Library (VDL) site.
Patch information and documentation is also available online at the MCA Learning Community for Event Capture site.
[bookmark: _Toc463463934]National Service Desk and Organizational Contacts
The three tiers of support documented herein are intended to restore normal service operation as quickly as possible and minimize the adverse impact on business operations, ensuring that the best possible levels of service quality and availability are maintained.
Table 1 lists organizational contacts needed by site users for troubleshooting purposes. Support contacts are listed by name of service responsible to fix the problem, description of the incident escalation, associated tier level, and contact information (email and phone number).
[bookmark: _Ref390770787][bookmark: _Toc393900385][bookmark: _Toc463464041]Table 1. Tier Support Contact Information
	[bookmark: ColumnTitle_03]Name
	Role
	Org
	Contact Info

	Local ECS Package Manager
	Tier 0 Support
	VHA
	ECS Package Manager/Site Dependent
http://vaww.dss.med.va.gov/dso/dso_list.asp 

	Local MCA VISN Coordinator
	Tier 0 Support
	VHA
	Site Dependent
http://vaww.dss.med.va.gov/dso/dso_list.asp 

	OI&T National Service Desk
	Tier 1 Support
	OI&T
	Nationalservicedeskanr@va.gov
1-855-673-4357
http://vaww.itsupportservices.va.gov/anrhome.asp 

	Health Product Support
	Tier 2 Support
	VHA
	Nationalservicedeskanr@va.gov
1-855-673-4357
http://vaww.itsupportservices.va.gov/anrhome.asp

	VistA Maintenance Management Systems
	Tier 3 Application Support
	OI&T
	OITPDVistAMaintenanceManagementSystems@va.gov
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[bookmark: _Toc463463935]System Summary
ECS is a VistA Class I workload reporting system supporting operations of the VA Managerial Cost Accounting Office (MCAO). There are several Veterans Health Administration (VHA) national programs mandating utilization of ECS in place of or to augment other workload capture information systems. For example, ECS is leveraged when programs cannot report workload in the form of Current Procedural Terminology (CPT) codes.  Other times, ECS allows for more precise workload capture and reporting than otherwise possible through another VistA system.
Event Capture with all patches installed provides the following functions:
Allows each VAMC to utilize the software for its own resource/costing needs
Implements DSS Units
Assigns user access
Allows single and batch data entry for patient procedures
Generates reports for workload and other statistical tracking
Provides a graphical user interface to the ECS application
Allows user to upload patient encounter data to Event Capture from a spreadsheet
Allows user to switch between Computerized Patient Record System (CPRS) and ECS without having to log back into the EC GUI.exe
[bookmark: _Toc463463936]System Configuration
Please refer to the Event Capture Technical Manual for details related to system and site configuration.
[bookmark: _Toc463463937]Data Flows
Figure 1 demonstrates the ECS data flow.
[bookmark: _Toc463464043]ECS Data Flow Diagram
[image: ]
[bookmark: _Ref450139287][bookmark: _Ref450139303][bookmark: _Toc463463938]User Access Levels
Security keys are assigned in VistA using the option Key Management main menu and then choosing the submenu Allocation of Security Keys.
ECS provides the following security key options for user access:
ECMGR: 	Gives a user access to the ECS Management Menu – only for Event Capture managers
ECALLU: 	Gives a user access to all DSS Units (super user).  This key should be assigned only to those managing the software (i.e., holders of the ECMGR key)
ECNORPT: 	Restricts the user from accessing Event Capture reports
ECSPSH: 	Gives a user access to upload data from a spreadsheet (required for State Home Spreadsheet upload)
[bookmark: _Toc463463939]Continuity of Operations
[bookmark: _Toc421025599][bookmark: _Toc422471145][bookmark: _Toc422471313]Each site has a backup emergency plan in place in the event that the system goes down.
[bookmark: _Toc463463940]Section 508 Compliance
Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies develop, procure, maintain, or use electronic and information technology, they shall ensure that the electronic and information technology enables persons with disabilities to have access to, and use of, information and data that is comparable to the access to and use of information and data by persons who are not individuals with disabilities, unless an undue burden would be imposed on the agency.
The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and modifications to the GUI have been made to meet the requirements for Section 508 compliance. Event Capture was modified to enable screen readers to accurately interpret information on the screens. As a result, some buttons and boxes have been moved, replaced or renamed, and some screen titles have been modified.
For more information on the VA Section 508 compliance efforts, please visit the Section 508 website.


[bookmark: _Toc463463941]Getting Started
Event Capture must be set up by using the options in the Event Capture Management Menu before any data can be entered. Access to this menu should be restricted to the ADPAC and his or her designees. The Event Capture ADPAC should use the following steps as a guide for setting up the Event Capture software.
 Select security keys.
See Section 2.3 of this document for a description of ECS security keys.
 Select required VistA settings.
Users must be assigned the EC GUI CONTEXT VistA menu options in order for the ECS GUI to work.
Create an Event Capture Location.
Create a location using the Location - Update Location Information option.
Notes:
The selected location must be in the INSTITUTION file (#4).
At least one location must exist before DSS Units can be established.
 Establish DSS Units for each service.
Contact each service for a list of its DSS Units, the names of its Event Capture users and the DSS Units for which they will enter data, and for individual product resource tracking needs. 
Use the DSS Unit - Add or Update DSS Units option to establish DSS Units for each service.
Note:
At least one DSS Unit must exist before Event Code Screens can be created.
 Assign user access to specific DSS Units.
Use the Access by User - Grant Access to DSS Units by User option to assign user access to specific DSS Units for the users identified in Step 4. 
Assign the ECALLU security key only to those users who should have access to all DSS Units.
Notes:
Users must have access to DSS Units before they can begin entering data.
Use the Access by User – Grant Access to DSS Units by User option to remove user access for a specific DSS Unit.  Users with the ECALLU security key cannot be denied access to DSS Units.
 Create Categories.
Use the Category - Add or Update Categories option to create categories before the user sets up Event Code Screens.
Notes:
Creating categories is optional.
After completion of this step, the Category Report option on the Reports Menu can be used to print a report of the site’s categories.
 Create or edit local procedures in the EC NATIONAL PROCEDURE file (#725).
Use the Procedure - Add or Update Local Procedures option to enter new, or edit existing, local procedures in the EC NATIONAL PROCEDURE file (#725). 
Adding local procedures is optional and not encouraged.
Notes:
Before starting this step, use the National/Local Procedure Report option on the Reports Menu to print a list of procedures with their associated CPT codes. This report can be quite lengthy if it includes national procedures, so it should be queued to print to a device during non-peak hours.
An associated CPT code must be entered to pass local procedures to PCE.
Use this option to edit, but not delete, existing local procedures and to select an associated CPT code if this workload data should be sent to PCE.
 Use the Event Code Screen - Add or Update Event Code Screens option to:
Create an Event Code Screen for each procedure tracked in the Event Capture software. 
[bookmark: OLE_LINK1][bookmark: OLE_LINK2]Enter or edit an optional active associated clinic for DSS Units that are marked to send data to PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be selectable. 
Enter or edit an optional procedure Synonym.
Set Ask Reasons? radio button to Yes or No.
Enter or edit procedure default Volume.
Note:
An Event Code Screen for the procedure must be created before it can be used for data entry.
 Optional: Print the Event Code Screens Sorted by DSS Units
Use the Print Category and Procedure Summary (Report) option on the Reports Menu to print the Event Code Screens sorted by DSS Units.
Notes:
Data entry clerks might find the output generated by this report useful as a procedure reference guide.
 Event Capture set up is complete.
Services can now enter data using the Data Entry options and provide summary reports using the Reports options.
[bookmark: _Toc463463942]Logging On
Event Capture is accessed through a desktop shortcut that points to the location of the EC GUI application. If the shortcut does not appear, refer to the Installation Guide for Event Capture, or ask the local support staff for assistance.
[bookmark: _Toc463464044]ECS GUI Icon
[image: Example of ECS GUI icon]
Double clicking the EC GUI shortcut will launch the application, and the VistA Sign-on screen will be displayed. Enter valid Access and Verify codes, then click the OK button.
[bookmark: _Toc463464045]VistA Sign-on Screen
[image: ]
[bookmark: _Toc463463943]Event Capture Main Menu
The Event Capture software contains four menus. The user must hold the ECSPSH security key to have access to the Spreadsheet option, and the ECMGR security key to have access to the Management Menu functions. Users without the ECMGR security key will have fewer reports available for selection than users with the ECMGR security key.  Users with the ECNORPT security key will not have access to the Reports option.
The following Main Menu options display when the Event Capture GUI opens.
[bookmark: _Toc463464046]Main Menu for Event Capture
[image: ]
[bookmark: _Toc463464047]Main Menu with the ECNORPT Security Key Added for the User
[image: ]
[bookmark: _Toc422471158][bookmark: _Toc422471326][bookmark: _Toc463463944]Icon Shortcuts
The icon shortcuts can be used to access options in Event Capture.
[bookmark: _Toc463464048]Icon Shortcuts
[image: ]
[bookmark: _Toc422471159][bookmark: _Toc422471327][bookmark: _Toc463463945]Menu Bar
The Event Capture menu bar enables the user to access shortcut commands.
[bookmark: _Toc463464049]Main Menu Bar
[image: ]
The File menu item enables the user to Exit the application. 
The Function menu item on the main window provides access to Data Entry, Spreadsheet (if the user has the proper security key), Reports and Management Menu functions. 
The View menu item enables the user to show or hide the Toolbar and Status Bar. 
The Help menu item provides topic-specific help, or information about the Event Capture system.
[bookmark: _Toc463464050]Main Menu Bar with Menus Expanded
[image: ]
[bookmark: _Toc422471160][bookmark: _Toc422471328][bookmark: _Toc463463946]Menu Bar for Specific Functions
The menu bar functions are described in the subsections below.
[bookmark: _Toc422470993][bookmark: _Toc422471161][bookmark: _Toc422471329][bookmark: _Toc422471497][bookmark: _Toc422471162][bookmark: _Toc422471330][bookmark: _Toc463463947]Data Entry Menu Bar
The Data Entry menu bar consists of the File, Edit, View, and Help menus.
[bookmark: _Toc463464051]Data Entry Menu Options
[image: ]
The File menu item provides the option for the user to Exit the window. 
The Edit menu item provides access to Data Entry by Patient, Data Entry by Procedure and Multiple/Multiple functions. 
The View menu item enables the user to show or hide the Toolbar and Status Bar. 
The Help menu item provides topic-specific help, or information about the Event Capture system.
[bookmark: _Toc463464052]Data Entry with Menus Expanded
[image: ]
[bookmark: _Toc422471163][bookmark: _Toc422471331][bookmark: _Toc463463948]Spreadsheet Menu Bar
The Spreadsheet menu bar consists of the File, Edit, EC Upload, Spreadsheet Options (if the user has the proper security key), and Help menus.
[bookmark: _Toc463464053]Spreadsheet Upload Options
[image: ]
The File menu item enables the user to Exit the window as well as Open Spreadsheet, Open State Home Spreadsheet, Close, Save, Save As and Print a file. 
The Edit menu item provides access to Cut, Copy, Paste, Insert Row and Delete Row functions. 
The EC Upload menu item enables the user to Upload Records to VistA. 
The Spreadsheet Options menu item enables the user to Change Column Headers or Change Duplicate Threshold. 
The Help menu item provides topic-specific help, or information about the Event Capture system.
[bookmark: _Toc463464054]Spreadsheet Menu with Menus Expanded
[image: ]
[bookmark: _Toc422471164][bookmark: _Toc422471332][bookmark: _Toc463463949]Reports Menu Bar
The Reports menu bar consists of the File, View, and Help menus.
[bookmark: _Toc463464055]Reports Menu Bar
[image: ]
The File menu item enables the user to Exit the window. 
The View menu item enables the user to show or hide the Toolbar and Status Bar. 
The Help menu item provides topic-specific help, or information about the Event Capture system.
[bookmark: _Toc463464056]Reports Menu with Menus Expanded
[image: ]
[bookmark: _Toc422471165][bookmark: _Toc422471333][bookmark: _Toc463463950]Management Menu Bars
The Management Menu bar consists of the File, Table, View, and Help menus.
[bookmark: _Toc463464057]Management Menu Options
[image: ]
The File menu item enables the user to Exit the window. 
The Table menu item provides access to Location, DSS Unit, Access by User, Category, Procedure, Reason, Event Code Screen and Inactivate EC Screen functions. 
The View menu item enables the user to show or hide the Toolbar and Status Bar. 
The Help menu item provides topic-specific help, or information about the Event Capture system.
[bookmark: _Toc463464058]Management Menu with Menus Expanded
[image: ]
[bookmark: _Toc463463951]Changing User ID and Password
To access ECS, users need a VistA Access Code and Verify Code. To change this, please contact the local Information Resource Manager (IRM).
[bookmark: _Toc463463952]Exit System
From the main Event Capture menu, click the Exit button to exit the Event Capture GUI. Alternatively, from the same screen, users can go to File > Exit, or click the Close window button in the top right corner of the screen.
[bookmark: _Toc437268363][bookmark: _Toc463463953]Caveats and Exceptions
On all ECS GUI screens, the previous Location entry will be saved and used as the default on subsequent Location fields.
[bookmark: _Toc421025601][bookmark: _Toc422471147][bookmark: _Toc422471315][bookmark: _Toc463463954]Online Documentation
Throughout the entire ECS GUI, click the question mark button located on the toolbar [image: Question Mark button that appears in Event Capture] or at the bottom right corner of the screen [image: Topic Help button screen capture (Ctrl and T)] to obtain online information for any screen. The information provided in the help menus corresponds to the information that is in this user manual.
To obtain online information for a field, click on that field and then press the <F1> key.
[bookmark: _Toc463464059]Online Help Screen
[image: ]
[bookmark: _Toc421025602][bookmark: _Toc422471148][bookmark: _Toc422471316][bookmark: _Toc463463955]Event Capture Interface with CPRS
The ECS GUI is accessible via CPRS. This design is intended to increase the use of Event Capture by clinicians currently using CPRS. The creation of a link and a single point of entry allow users to access both systems. 
The interface between CPRS and Event Capture enables users to:
Access Event Capture from within CPRS through a single sign-on.
Select Event Capture Interface in the CPRS Tool Menu allowing the user to enter Event Capture patient procedures. This requires set up by local IRM and/or the Clinical Application Coordinator.
[bookmark: _Toc422471149][bookmark: _Toc422471317][bookmark: _Toc463463956]Timeout Feature
Event Capture includes a timeout feature consistent with CPRS. A countdown screen will display a warning of the pending timeout of the application when the Event Capture application is idle for a user-defined amount of time. If the user takes no action, the application will close. Click on the Do not close Event Capture button to stay connected.
[bookmark: _Toc463464060]Event Capture Timeout Screen
[image: ]
The amount of time for the timeout and countdown features is user-defined at the application server level.
[bookmark: _Toc422471150][bookmark: _Toc422471318][bookmark: _Toc463463957]CCOW Single Sign On
Event Capture includes Clinical Context Object Workgroup (CCOW) Single Sign-on capability. If a user is signed onto another CCOW Single Sign-on enabled system, launching Event Capture will not require the user to re-enter system Access and Verify codes. The status of the CCOW single sign-on is shown via an icon on a panel in the upper right hand corner of the Main Menu. The hover help will display “Clinical Link On” if Event Capture was accessed via CCOW single sign-on, or “Clinical Link Off” if it was not. The icon on the panel is updated as well.
[bookmark: _Toc463464061]Event Capture CCOW Status
[image: ]


[bookmark: _Toc463463958]Using the Software
[bookmark: _Toc421025619][bookmark: _Toc422471167][bookmark: _Toc422471335][bookmark: _Toc463463959]Data Entry Menu
The Data Entry menu offers the following options:
Data Entry by Patient – Enter/Edit Patient Procedures
[bookmark: p114_17][bookmark: Menu_Same_Proc_Multi_Patients]Data Entry by Procedure – Batch (Same Procedure, Multiple Patients)
Multiple Dates/Procs – Multiple Dates / Multiple Procedures
[bookmark: _Toc463464062]Data Entry Menu Screen
[image: ]
[bookmark: _Toc421025620][bookmark: _Toc422471168][bookmark: _Toc422471336][bookmark: _Toc463463960]Data Entry by Patient
Use the Data Entry by Patient option to:
Enter a single procedure for one patient
Edit an existing patient procedure
Delete an existing patient procedure
Note: 
Event Code Screens must be defined before entering any Event Capture data.

Users will be presented with:
A summary screen to identify the Location, DSS Unit, Procedure Date Range, Patient Identifier and any existing procedures for that patient
A detail screen to show the detailed information about a selected patient procedure
[bookmark: _Toc463464063]Enter/Edit Patient Procedures Screen
[image: ]
[bookmark: _Toc422471171][bookmark: _Toc422471339]To use the Enter/Edit Patient Procedures screen:
1. Select a Location.
If there is only one Location set up in ECS, the Location on the screen will default to that value.
If there is more than one Location set up in ECS, the Location on the screen will default to the last Location used. To change the Location, choose a Location from the dropdown list.
 Select a DSS Unit.
If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or if only one DSS Unit is assigned to the user, that DSS Unit value will default.
If only one DSS Unit is assigned to the user, it will be the default selection. If more than one DSS Unit is assigned to the user, choose a DSS Unit from the dropdown list of accessible DSS Units.
The user can add, edit or delete any patient procedure for the selected DSS Unit.
To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add or Update DSS Units function to add the unit to the dropdown list. The ECMGR key is required.
 Select a Date Range.
The Procedure Date Range (from/through) will default to the system date. These fields may be edited by typing in a date (dd MMM yyyy) or by using the calendar dropdown.
Note:
An edit check will prevent selecting a date in the future, or displaying a Procedures From date later than the Procedures Through date.
[bookmark: _Toc463464064]Calendar Dropdown for Date Range View
[image: ]
 Use the Patient Identifier field to select a patient.
Enter one of the following:
Patient Name (whole or partial, last name first)
Social Security Number
Last four digits of the Patient Social Security Number
First character of Last Name plus the last four digits of the SSN with no spaces
Click <Enter> or the Search button.
Choose from the list of patients displayed.
 View the Patient Procedures.
Once the previous steps are complete, the bottom section of the window will display the patient procedures in chronological order for the selected search criteria. Each record will display the Category, Procedure, Date/Time, Volume, Associated Clinic, Ordering Section, Primary Diagnosis and Primary Provider.
Notes:
Click on the field header to sort the data in a different order.
The Close, Add and Topic Help buttons are always enabled. If patient procedures exist, the Update and Delete buttons will be enabled, as well.
Clicking on a row will highlight the patient procedure, effectively selecting that row as a candidate for updating or deleting.
[bookmark: _Toc463464065]Procedure History for Sample Patient
[image: ]
 Complete data entry.
Click the Add button to enter a new patient procedure.
Click the Update button to display the patient procedure on the Edit Patient Procedure (Detail) screen.
Click the Delete button to delete the patient procedure from the file.
[bookmark: _Toc422471172][bookmark: _Toc422471340][bookmark: _Toc463463961]Recent Visits Screen
To see the Recent Visits screen: 
1. On the Enter/Edit Patient Procedures screen, click the Add button to enter a new patient procedure.
Notes:
The Add button will only display if the selected DSS Unit is set to send to PCE.
If recent visits exist, the Recent Visits screen will be displayed after clicking the Add button.
[bookmark: _Toc463464066]Recent Visits Screen
[image: ]
Selection options on the Recent Visits screen.
On the Recent Visits screen, the user can choose one of three options: OK, Ignore or Cancel.
OK:  Select the appropriate Appointment/Encounter from the Recent Visits. Click the OK button to close the screen. The Add Patient Procedure screen will display with the Procedure Date/Time and Associated Clinic fields populated and not modifiable, based on the Appointment/Encounter selected on the Recent Visits screen. Enter the procedure(s), answer classification questions as they pertain to that visit, and enter diagnoses, provider, and other pertinent fields if required (reasons, ordering section and/or modifiers).
Ignore: Click the Ignore button on the Recent Visits screen to go to the Add Patient Procedure screen to enter information for all fields.
Cancel: Click the Cancel button to close the Recent Visits screen and return to the Enter/Edit Patient Procedures screen.
Note:
If the Associated Clinic for the selected record is no longer active, clicking the OK button will result in the display of the Error: Invalid Associated Clinic message dialog.  The message dialog lists only active Associated Clinics. To update the record, select an active clinic from the list and then click the OK button. Click the Cancel button to open the record and the Associated Clinic field will be blank.
[bookmark: _Toc463464067]Error: Invalid Associated Clinic Message Dialog
[image: ]
[bookmark: _Toc463464068]Add Patient Procedure Detail Screen
[image: ]
[bookmark: _Toc422471173][bookmark: _Toc422471341][bookmark: _Ref462226854][bookmark: _Toc463463962]Add Information to the Add Patient Procedure or Edit Patient Procedure Screen
To complete the Add Patient Procedure or Edit Patient Procedure screen:
1. Select a Category
If the Allow Category Use field in the Add DSS Unit Management set up is set to NO, then the Category field will be blank and disabled.
If only one Category is defined for the specified DSS Unit, that Category will be the default value.
Select the Procedure Date and Time.
This information is present if a recent visit was selected on the Recent Visits screen.
Typing “N” and then clicking <Enter> in the field (instead of clicking the [image: ... button] button) will bypass the dialog box, or clicking the Now button in the dialog box will enter the current system date and time. When the Midnight button is clicked, “23:59” is displayed for the time on the date selected.
[bookmark: _Toc463464069]Select Date/Time Dialog Box
[image: ]
Select an Eligibility Code for this procedure.
If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.
The primary Eligibility Code displays as the default.
Select a Procedure Name.
Select a Procedure from the dropdown list.
Enter the Volume for the procedure.
If applicable, the CPT Modifiers section will be enabled.
Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will show.
Choose a modifier from the Modifiers Available list and click Include.
Repeat as needed.
To remove a modifier, choose it from the Modifiers Selected list and click Exclude.
Press <CTRL-Click> to select multiple modifiers at one time.
If applicable, the Reasons field will be enabled.
The user can enter up to three reasons.
Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
Reasons appear alphabetically in the dropdown.
Once selected, a reason will not appear in the dropdown list for remaining reason fields.
A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason, or enter different letter(s).
If applicable, the mandatory classification questions section will be enabled.
Select YES only if the treatment received relates to that classification.
Press the <F1> key while in the Service Connected field to display a message dialog containing the patient’s service connection and any rated disabilities.
[bookmark: _Toc463464070]Service Connection and Rated Disabilities Screen
[image: ]
Select the Ordering Section.
Select the Associated Clinic (if not already populated from the Recent Visits screen).
Select the associated diagnosis code for the procedure.
Use the Primary field to enter one of the following:
ICD code (whole or partial)
Diagnosis Name (whole or partial)
Click the Search button. [image: Screen capture of search button.]
Select from the resulting dropdown list.
Repeat as needed to select the secondary diagnosis codes.
Select the providers of the services. Use the Providers Available text box to enter the following:
Provider name (full or partial, last name first)
Select the provider from the resulting dropdown list and click Include.
To remove a provider, select from the Providers Selected list and click Exclude. 
Click the Add button to save the edited procedure and remain on the screen.
Click the OK button to save the edited procedure and return to the Enter Patient Procedure screen.
Click the Cancel button to return to the Enter Patient Procedure screen without saving the above entries.
Notes:
If the record transmits to PCE based on the DSS Unit on Management Menu set up, then all fields will be required.
If the record does not transmit to PCE based on the DSS Unit on Management Menu set up, then the Associated Clinic and the four Secondary Diagnosis fields will be disabled.
Press the <F1> key while in any field to open a dialog box displaying a help message.
[bookmark: _Toc422471174][bookmark: _Toc422471342][bookmark: _Toc463463963]Add a Patient Procedure
The following instructions and example assume that a user is entering a patient procedure for a specified patient and that the specified DSS Unit data transmits to PCE.
1. On the main Event Capture menu, select Data Entry.
On the Data Entry Menu, select Data Entry by Patient.
The Enter/Edit Patient Procedures screen appears. 
Select the Location and DSS Unit.
Allow the Procedure Date Range to default to today.
Select a Patient.
[bookmark: _Toc463464071]Enter/Edit Patient Procedures Screen
[image: ]
Click Add.
If the DSS Unit is set to send to PCE, the Recent Visits screen will appear. Select a scheduled appointment and click OK.
[bookmark: _Toc463464072]Recent Visits Screen
[image: ]
Complete the procedure-related fields on the Add Patient Procedure detail screen according to the field-by-field instructions given in Section 4.1.1.2.
[bookmark: _Toc462237032][bookmark: _Toc463464073]Add Patient Procedure Screen
[image: ]
Click Add to save the record and clear the fields to add another procedure for this patient.
Click the OK button to save the record and return to the Enter/Edit Patient Procedures screen.
The Enter/Edit Patient Procedures screen will display any existing procedures for this patient.
[bookmark: _Toc463464074]Enter/Edit Patient Procedures with New Procedure Added
[bookmark: Graphic_EnterEdit_Patient_Procedures][image: ]
Click Close to return to the Data Entry menu.
[bookmark: _Toc462236873][bookmark: _Toc422471175][bookmark: _Toc422471343][bookmark: _Toc463463964]Edit a Patient Procedure
1. On the main Event Capture menu, select Data Entry.
On the Data Entry Menu, select Data Entry by Patient.
The Enter/Edit Patient Procedures screen appears.
[bookmark: _Toc463464075]Enter/Edit Patient Procedures Screen
[image: ]
Select the Location and DSS Unit.
Enter a Procedure Date Range by using the calendar dropdowns. The default is today.
Select a patient.
The lower portion of the screen will display the procedure(s) for the selected patient and the DSS Unit within the date range.
Choose a procedure and click Update.
The Edit Patient Procedure screen appears.
[bookmark: _Toc463464076]Edit Patient Procedure Screen
[image: ]
Complete the procedure-related fields on the Edit Patient Procedure detail screen according to the field-by-field instructions given in section 4.1.1.
Click Add to save the detail entries and open another detail screen for this patient.
Click the OK button to save the detail entries and return to the Enter/Edit Patient Procedures screen.
The Enter/Edit Patient Procedures screen will display the procedure(s) (Figure 32) entered for this patient.
Click Close to return to the Data Entry menu.
[bookmark: _Toc422471176][bookmark: _Toc422471344][bookmark: _Toc463463965]Delete a Patient Procedure
1. On the main menu, select Data Entry.
On the Data Entry Menu, select Data Entry by Patient.
The Enter/Edit Patient Procedures summary screen appears.
[bookmark: _Toc463464077]Enter/Edit Patient Procedures Screen
[image: ]
Select the Location and DSS Unit.
Enter a procedure date range by using the calendar dropdowns. The default is today.
Select a patient.
The lower portion of the screen will display the procedure(s) for the selected patient and the DSS Unit within the date range.
Choose a procedure and click Delete.
A confirmation message appears. 
Click the Yes button on the confirmation message dialog, and an Information message dialog appears to show the selected procedure was deleted for the patient. Click the OK button to return to the Enter/Edit Patient Procedures screen.
Click the No button on the confirmation message dialog to return to the Enter/Edit Patient Procedures screen without deleting the procedure.
[bookmark: _Toc463464078]Procedure Deleted Confirmation Dialog
[bookmark: _Toc422742752][image: ]
[bookmark: _Toc463464079]Confirmation Message
[image: ]
The screen will now refresh to show the remaining procedures entered for this patient.
[bookmark: _Toc463464080]Enter/Edit Patient Procedures Screen with Procedure Deleted
[image: ]
Click Close to return to the Data Entry menu.
[bookmark: _Toc455131581][bookmark: _Toc422471177][bookmark: _Toc422471345][bookmark: _Toc463463966]Data Entry by Procedure
Use the Data Entry by Procedure option to:
Enter/edit the same procedure for multiple patients
Note: 
Event Code screens must be defined before entering any Event Capture data.

Users will be presented with:
The left side of the screen contains information for the procedure that the system will use for all patients. (Note: The user will enter the procedure information only one time.)
The right side of the screen identifies each patient. The user will complete this section for each patient. Click Add to file the data, and clear the fields to enter data for the next patient.
The View button displays a listing of all patients entered for this procedure in this session.
[bookmark: _Toc455135716][bookmark: _Toc422742755][bookmark: _Toc463464081]Same Procedure, Multiple Patients Screen
[image: ]
[bookmark: _Toc422471180][bookmark: _Toc422471348][bookmark: _Toc463463967]Add a Procedure for Multiple Patients
The following instructions and example assume that the user wants the specified DSS Unit to send data to PCE.
1. Select a Location.
If there is only one Location set up for the Event Capture System, the Location on the screen will default to that value.
If there is more than one Event Capture Location set up, the Location will default to the last Location used. To change the Location, choose a Location from the dropdown list of available Event Capture Locations.
Select a DSS Unit.
If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, that DSS Unit will be the default value.
If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a dropdown list of accessible DSS Units.
The user can add, edit or delete any patient procedure for the selected DSS Unit.
To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add or Update DSS Units function to add the unit to the dropdown list.
Select a Category.
If only one category is defined for the specified DSS Unit, that category will be the default.
Select the Procedure Date and Time.
Typing “N” and then clicking <Enter> in the field (instead of clicking the [image: Screen capture of a shortcut button to select the date and time as the current date and time.] button) will bypass the date/time dialog, or clicking the Now button on the date/time dialog will enter the current system date and time. When the Midnight button is clicked, “23:59” is displayed for the time on the date selected.
[bookmark: _Toc422742756][bookmark: _Toc463464082]Select Date/Time Dialog
[image: ]
Select a Procedure Name.
Select a procedure from the dropdown list.
If applicable, the Reasons field will be enabled. 
The user can enter up to three reasons.
Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
Reasons appear alphabetically in the dropdown.
A reason will not appear in the dropdown list for remaining reason fields as an option once selected.
A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason or enter different letter(s).
If applicable, the CPT Modifiers section will be enabled.
Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will show.
Choose a modifier from the Modifiers Available list and click the right pointer icon[image: Right pointing finger]. Repeat as needed.
To remove a modifier, choose it from the Modifiers Selected list and click the left pointer icon [image: Left pointing finger]. 
Press <CTRL-Click> to select multiple modifiers at one time.
Select the providers of the services. Use the Providers Available text box to enter the following:
Provider name (full or partial, last name first)
Select the provider from the resulting dropdown list and click the right pointer icon [image: Right pointing finger].
To remove a provider, select from the Providers Selected list and click the left pointer icon  [image: Left pointing finger].
Use the Patient Identifier field to select a patient.
Enter one of the following:
Patient Name (whole or partial, last name first)
Social Security Number
Last four digits of the Patient Social Security Number
First character of Last Name plus the last four digits of the SSN with no spaces
Click <Enter> or the Search button. [image: Search goggles example]
Choose from the list of patients displayed. 
Select an Eligibility Code for this procedure.
If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.
The primary Eligibility Code displays as the default.
Enter the Volume for the procedure.
If applicable, the mandatory classification questions section will be enabled.
Select YES only if the treatment received relates to that classification.
Pressing the <F1> key while in the Service-Connected field will open a message dialog displaying the patient’s service connection and any rated disabilities.
[bookmark: _Toc422742757][bookmark: _Toc463464083]Service Connection and Rated Disabilities Dialog
[image: ]
Select the Ordering Section.
Select an Associated Clinic for the specified DSS Unit, if applicable.
Select the associated diagnosis code for the procedure.
Use the Primary field to enter one of the following:
ICD code (whole or partial)
Diagnosis Name (whole or partial)
Click the Search button. [image: Screen capture of search button]
Select from the resulting dropdown list.
Repeat as needed to select the Secondary Diagnosis Codes.
Click the Add button to add this procedure for the patient. The right side of the screen will reset to enter this procedure for another patient. Select the next patient for this procedure. Repeat the patient related steps above.
Click the OK button to add this procedure to the patient’s record and return to the Data Entry menu.
Click the View button to verify that the list of patients entered is correct. The following screen will list all of the patients entered for the procedure that was selected.
[bookmark: _Toc422742758][bookmark: _Toc463464084]View Patients for this Procedure Screen
[image: ]
To correct an entry, return to the Data Entry menu and select Data Entry by Patient.
[bookmark: _Toc455131583][bookmark: _Toc421025633][bookmark: _Toc422471181][bookmark: _Toc422471349][bookmark: _Toc463463968]Multiple Dates / Multiple Procedures
Use the Multiple Dates / Multiple Procedures option to:
Add multiple dates and multiple patients for multiple procedures.
Notes:
Event Code screens must be defined before entering any Event Capture data.
Use the Data Entry by Patient option to make corrections to erroneous patient data.
Users will be presented with:
An area at the top of the first screen for entering common fields (Location, DSS Unit and Category) as well as the Procedure Date/Time.
Three tabs for entering providers, procedures and patients.
Two tabs for checking work before submitting.
[bookmark: _Toc422742759][bookmark: _Toc463464085]Multiple Dates/Multiple Procedures Screen – Initial Screen
[image: ]
[bookmark: _Toc422471184][bookmark: _Toc422471352][bookmark: _Toc463463969]Instructions for Common Fields
1. Select a Location.
If there is only one Location set up for the Event Capture System, the Location on the screen will default to that value.
If there is more than one Event Capture Location set up, the Location will default to the last Location used. To change the Location, choose a Location from the dropdown list of available Event Capture Locations.
Select a DSS Unit.
If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, that DSS Unit will be the default value.
If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a dropdown list of accessible DSS Units.
The user can add, edit or delete any patient procedure for the selected DSS Unit.
To gain access to an existing DSS Unit, go the Event Capture Manager must assign it to the user.
Select a Category.
If categories are not allowed in the DSS Unit, the selection box will be disabled.
If only one category is defined for the specified DSS Unit, that category will be the default.
Select the Procedure Dates and Time by using the Select Date/Time dialog.
[bookmark: _Toc422742760][bookmark: _Toc463464086]Select Date/Time Dialog
[image: ]
Select date and time and click the OK button to close the dialog.
Click the Add Date/Time button to add the choice to the Selected Dates list.
Select and add dates as needed.
To remove a date, choose it from the list and click the Delete Date/Time button.
Notes:
To bypass the Date/Time dialog, type “N” and press <Enter> in the field (instead of clicking the [image: Shortcut button that allows the user to select now as the date and time.] button.)
To enter the current system date and time, click the Now button on the Date/Time dialog.
When the Midnight button is clicked, “23:59” is displayed for the time on the date selected.
Click and complete the tabs for Providers, Procedures and Select Patient as described in Sections 4.1.3.2, 4.1.3.3, and 4.1.3.4.
Use the View Selected Patients and Records Pending Filing tabs to check the work as described in Sections 4.1.3.5 and 4.1.3.6.
Click the Save button at the bottom of the screen to process the transactions shown on the Records Pending Filing tab, and then redisplay the screen initialized for a new set of entries.
Click the OK button at the bottom of the screen to process the transactions shown on the Records Pending Filing tab, and then return to the Data Entry menu.
[bookmark: _Toc422471185][bookmark: _Toc422471353][bookmark: _Ref460506664][bookmark: _Toc463463970]Add Information to Providers Tab
1. Click on the Providers tab to select one or more providers.
[bookmark: _Toc422742761][bookmark: _Toc463464087]Multiple Dates/Multiple Procedures Screen, Providers Tab
[image: ]
Select a Provider.
Use the Providers Available list to enter the full or partial provider name (last name first)
Select the provider from the resulting dropdown list and click the Include button.
To remove a provider, select from the Providers Selected list and click the Exclude button.
Repeat as needed to add providers.
[bookmark: _Toc422471186][bookmark: _Toc422471354][bookmark: _Ref460506677][bookmark: _Toc463463971]Add Information to Procedures Tab
1. Click on the Procedures tab to select one or more procedures.
[bookmark: _Toc422742762][bookmark: _Toc463464088]Multiple Dates/Multiple Procedures Screen, Procedures Tab
[image: ]
Select a Procedure Name.
Select a procedure from dropdown list.
Enter the Volume for this procedure.
If applicable, the Reasons field will be enabled.
The user can enter up to three reasons.
Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
Reasons appear alphabetically in the dropdown.
A reason will not appear in the dropdown list for remaining reason fields as an option once selected.
A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason or enter different letter(s).
If applicable, the Modifiers section will be enabled.
Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will display.
Choose a Modifier from the Modifiers Available list and click the Include button.
Repeat as needed.
To remove a modifier, choose it from the Modifiers Selected list and click the Exclude button.
Click <CTL-Click> to select multiple modifiers at one time.
Click the Add Procedure button to add this procedure to the Procedures Selected list and display a blank screen ready for another entry.
To add another procedure, repeat the steps above.
To delete a procedure, choose it from the Selected Procedures list and click the Delete Procedure button.
To view a procedure in an expanded format, choose it from the Selected Procedures list and click the View Details button. The View Procedure Record Details screen is not editable.
[bookmark: _Toc422742763][bookmark: _Toc463464089]View Procedure Record Details Screen
[image: ]
Click the Close Procedure View button to return to the Procedures tab.
[bookmark: _Toc422471187][bookmark: _Toc422471355][bookmark: _Ref460506705][bookmark: _Toc463463972]Add Information to Select Patient Tab
1. Click on the Select Patient tab to select one or more patients.
[bookmark: _Toc422742764][bookmark: _Toc463464090]Multiple Dates/Multiple Procedures Screen, Select Patient Tab
[image: ]
Use the Patient Identifier field to select a patient.
Enter one of the following:
Patient Name (whole or partial, last name first)
Social Security Number
Last four digits of the patient Social Security Number
First character of Last Name plus the last four digits of the SSN with no spaces
Press <Enter> or click the Search button. [image: Searcg goggles button]
Choose from the list of patients displayed. 
Select an Eligibility Code for this procedure.
If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure. 
The primary Eligibility Code displays as the default.
If applicable, the mandatory Encounter Related classification questions section will be enabled.
Select YES only if the treatment received relates to that classification.
Pressing the <F1> key while in the Service-Connected field will open a message dialog displaying the patient’s service connection and any rated disabilities.
[bookmark: _Toc422742765][bookmark: _Toc463464091]Service Connection and Rated Disabilities Dialog
[image: ]
Select the Ordering Section.
Select the Associated Clinic.
Select the associated diagnosis code for the procedure.
Use the Primary field to enter one of the following:
ICD code (whole or partial)
Diagnosis Name (whole or partial)
Click the Search button. [image: Screen capture of the search button]
Select from the resulting dropdown list.
Repeat as needed to select the Secondary Diagnoses Codes.
Click the Add Patient button to add this patient to the list of Selected Patients and display a blank screen ready for another entry.
Use the View Selected Patients tab to check the work.
[bookmark: _Toc422471188][bookmark: _Toc422471356][bookmark: _Ref460506624][bookmark: _Toc463463973]Verify Information Using the View Selected Patients Tab
1. Click on the View Selected Patients tab to review the list of selected patients.
[bookmark: _Toc422742766][bookmark: _Toc463464092]Multiple Dates/Multiple Procedures View Selected Patients Tab
[image: ]
To remove a patient from the list, select record and click the Delete Patient button. Click the Yes button on the Confirmation message dialog.
[bookmark: _Toc422742767][bookmark: _Toc463464093]Deleting Patient Confirmation Dialog
[image: ]
To view a patient in an expanded format, select the record and click the View Details button. The patient record is not editable using the View Patient Record Detail screen.
[bookmark: _Toc422742768][bookmark: _Toc463464094]View Patient Record Details Screen
[image: ]
Click the Close Patient View button to return to the View Selected Patients tab.
[bookmark: _Toc422471189][bookmark: _Toc422471357][bookmark: _Ref460506630][bookmark: _Toc463463974]Verify Information Using the Records Pending Filing Tab
1. Click on the Records Pending Filing tab to view a list of the records to be filed. 
Note:
This screen is not editable.
[bookmark: _Toc422742769][bookmark: _Toc463464095]Multiple Dates/Multiple Procedures Records Pending Filing Tab
[image: ]
This screen lists the individual records (transactions) that will be processed when the OK or Save button at the bottom of the screen is clicked. An information dialog will appear on the screen to show the number of records added.
Note:
Click the OK button to return to the Data Entry menu, or click Save to add more entries.
[bookmark: _Toc422742770][bookmark: _Toc463464096]Information Dialog after Saving
 [image: ]
The records consist of every combination of the dates, procedures, and patients selected on the tabs described in the preceding sections, and the providers selected will be assigned to each record.
To change the list, review and revise the selections on the Providers, Procedure and Select Patient tabs and for the Selected Dates/Times field.
To correct an entry, return to the Data Entry menu and select Data Entry by Patient.
[bookmark: _Toc421025642][bookmark: _Toc422471190][bookmark: _Toc422471358][bookmark: _Toc463463975]Spreadsheet
Data can be batch processed in the Event Capture GUI using the spreadsheet import and upload options.  Two types of spreadsheet can be used for this data entry – the original “regular” spreadsheet, or the new State Home spreadsheet. Both methods of import are launched from the Spreadsheet Upload screen. Once a spreadsheet is imported into Event Capture, the data can be uploaded to VistA.
The user will see a Spreadsheet Upload screen similar to the screenshot below.
[bookmark: _Toc463464097]Spreadsheet Upload Screen
[image: ]
[bookmark: _Toc463463976]Import a Regular Spreadsheet
This is the traditional method for batch processing spreadsheet data that has been available since the inception of the Event Capture GUI. The spreadsheet import functionality works with MS Excel® files, as well as with tab or comma delimited files. All versions of Excel spreadsheets are compatible with this functionality.
Notes:
A template with default column order is available to aid in populating spreadsheets prior to import.  The header row will not be processed when data are imported; therefore, it can remain in the spreadsheet during the import process.
The template is available on the VA EC Template.xlsx.
Once the template is downloaded, save it to a local hard drive for later use.
Steps for importing a regular spreadsheet:
1. Click the Open a Regular Spreadsheet button [image: ], or select the Open Spreadsheet option from the File menu. A standard Select File dialog will be displayed, allowing the user to select the spreadsheet to be imported.
Note:
Both *.XLS (pre- 2007) and *.XLSX versions of MS Excel spreadsheets are valid for use in the Event Capture spreadsheet import process.
[bookmark: _Toc463464098]Select File Dialog - Open a Spreadsheet
 [image: ]
Once the desired spreadsheet is selected for import, click the Open button. The data are then imported into Event Capture, and will be displayed in the grid of the Spreadsheet Upload form.
[bookmark: _Toc463463977]Data Imported and Ready for Upload
Figure 57 is an example of the data that were imported from a spreadsheet into Event Capture.
[bookmark: _Toc463464099]Imported Spreadsheet Data Shown in the Spreadsheet Upload Form
 [image: ]
[bookmark: _Toc463463978]Edit Cell Data on the Spreadsheet Upload Form
All imported data can be modified in the Spreadsheet Upload form. The information from the selected cell is displayed in the Cell Data edit box (located above the grid). The value can be changed in either the edit box or the cell itself.
The contents of an individual cell can be deleted using either the Cell Data edit box, or by highlighting the cell and pressing the <Delete> key.
To delete an ENTIRE RECORD, click once on a cell, then press the <Delete> key on the keyboard.
Note:
Help is available for each column in the spreadsheet. Click on any column, and then click the Help button [image: Screen capture of Help button.].
[bookmark: _Toc463463979]Modify Column Order
When the Spreadsheet Upload form is opened, the column headers are displayed in a default order. The user can change the order of the columns if the EC Template is not used. 
1. Click the Column Header button [image: Screen capture of Column Header button], or select the Change Column Headers option from the Spreadsheet Options menu. The Column Headers form (Figure 4.2-6) will be displayed.
[bookmark: _Toc463464100]Column Headers Form
[image: ]
To change the order of the columns, highlight the column heading from the list and click either the Move Up or Move Down button. 
Repeat step 2 until the column order matches the columns order of the spreadsheet. Click the Apply button to save the column order.
Note:
The default column header order is as follows:
Record Num
Location
Pat SSN
Pat LName
Pat FName
DSS Unit Name
DSS Unit Num
DSS Unit IEN
Proc Code
Volume
Ordering Sect
Enc Date/Time
Category
Diag Code
Assoc Clinic Name
Assoc Clinic IEN
Mod 1
Mod 2
Mod 3
Mod 4
Mod 5
Agent Orange
Ion Rad
Service Conn
SW Asia
Mil Sexual Trauma
Head Neck Cancer
Combat Vet
SHAD
Camp Lejeune (Note: As of Patch EC*2*131, this column is a placeholder)
Prov 1 Name or IEN
Prov 2 Name or IEN
Prov 3 Name or IEN
Prov 4 Name or IEN
Prov 5 Name or IEN
Prov 6 Name or IEN
Prov 7 Name or IEN
[bookmark: _Toc463463980]Upload Imported Spreadsheet Data
To start the upload process, click the Upload Records to VistA button [image: Screen capture of Update Records to VistA button] on the toolbar, or select the Upload Records to VistA option from the EC Upload menu.
Each record in the imported spreadsheet is validated before being filed in the Event Capture Patient file (#721). 
Two levels of validation occur:
1. The first level of validation occurs within the Event Capture GUI application. A check for required information is performed, and no data transmits to VistA if this level of validation fails for any record in the spreadsheet. 
2. The second level of validation occurs on the server side for each record in the spreadsheet.  Records that pass this level of validation are filed in the EVENT CAPTURE PATIENT file (#721); records that fail this level of validation are not filed.  Records that are filed are removed from the spreadsheet grid, leaving only those records containing errors. Each of the remaining records in the spreadsheet will have its associated error message(s) displayed in the Error Messages box. The errored record(s) can then be edited before retransmitting, or deleted.
Hint:  Click on an error message to highlight the cell in the grid that most likely caused the error. This will assist in identifying, and correcting, missing or invalid data.
[bookmark: _Toc463463981]Spreadsheet Column Errors
The following errors may display while uploading data into Event Capture via the Spreadsheet option:
Record Number:  When transmitting records, each row in the spreadsheet needs a unique record number (i.e. 1, 2, 3, etc.).  If this field is blank, VistA validation will not be done.
Delphi messages:
Error getting column with record number
Record number is a mandatory field
Location:  The location number must exist on the INSTITUTION file (#4) (also known as ^DIC(4,D0,0), where D0 is the location number).
VistA message:
Location not on INSTITUTION file (#4)
Pat SSN:  The Patient SSN must exist on the PATIENT file (#2) (also known as global file ^DPT).  If the SSN is shorter than 9 digits, it will be filled with leading zeroes.  Do not use dashes in the SSN.
VistA messages:
No SSN x-ref on PATIENT file (#2)
No SSN entry on PATIENT file (#2)
No internal entry on PATIENT file (#2) for SSN x-ref
SSN does not match SSN on PATIENT file (#2)
Patient LName and Patient FName:  The patient’s name (last name, first name) must match the name on the PATIENT file (#2) for that SSN.
Delphi messages:
Error getting column with Patient LName
Patient LName must be at least 2 characters long
VistA messages:
Patient last name does not match VistA
Patient first name does not match VistA
DSS Unit Name:  If this field contains a value, then it must have a “B” cross-reference on the DSS UNIT file (#724). The DSS Unit Name is not required if either the DSS Unit Number or the DSS Unit IEN contains a value.
VistA message:
Invalid DSS Unit Name
DSS Unit Number:  This is the Unit Number, found on the DSS UNIT file (#724). If this field contains a value, then it must have a “C” cross-reference on the DSS UNIT file (#724). The DSS Unit Number is not required if either the DSS Unit Name or the DSS Unit IEN contains a value.
VistA message
Invalid DSS Unit Number
DSS Unit IEN:  If this field contains a value, then it must exist on the DSS UNIT file (#724). The DSS Unit IEN is not required if either the DSS Unit Name or the DSS Unit Number contains a value.
VistA message
Invalid DSS Unit IEN
Proc Code:  This is the Procedure or the CPT code value (not the description). A National Procedure, Local Procedure or CPT code is valid for this column. Either the Procedure must exist in the EC NATIONAL PROCEDURE file (#725), or the CPT must exist in the CPT file (#81). In addition, the Event Code Screen must be active for the Location, DSS Unit IEN, and Procedure/CPT combination. With functionality put in place by the Code Set Versioning project, only CPT codes that are active for the date and time of the event are processed.
VistA messages
Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725)
Procedure invalid for this Location and DSS Unit
Unable to check for active EC Event Code Screen
Volume:  The volume must be a number from 1 through 99.
Delphi error messages
Error getting column with Volume number
Volume is a mandatory field
Volume has a limit of 2 digits
VistA messages
Volume must be a number from 1 to 99
Volume must contain numeric characters only
Ordering Section:  This is the name of the Ordering Section. Validation (against the “B” cross-reference in the MEDICAL SPECIALTY file (#723)) occurs for Ordering Section values used in the spreadsheet. If this field is blank, the program will derive the Ordering Section from the DSS UNIT file (#724) using the DSS Unit IEN. The record will then be transmitted to the Event Capture filer program.
VistA message
Invalid Ordering Section
Unable to determine Ordering Section
Prov Name or IEN:  This is the Provider’s last and first name as it appears in the “B” cross-reference of the NEW PERSON file (#200). If the provider also has a middle initial, then it should be included (e.g. ‘ECPROVIDER, SEVEN J’). If the system finds a partial match for the name, the application will return the provider information (provider name, IEN, specialty, subspecialty, person class), and the user can then determine which provider is correct. The Provider Name must have a “B” cross-reference in the NEW PERSON file (#200), and the person class must be active.
VistA messages
Provider has no B x-ref on NEW PERSON file (#200)
Unable to determine person class
Provider does not have an active person class
Enc Date/Time:  The Encounter Date/Time can be in any valid FileMan format.

Examples:
mm/dd/yy @hh:mm
mm/dd/yyyy @hh:mm
mm-dd-yy @hh:mm
mmddyy @hhmm
N, N-1, N-1H, etc.
VistA message
Invalid encounter date/time
Category:  The Category field can be blank. If the user enters a value, it needs to have a “B” cross-reference in the EC CATEGORY file (#726).
VistA message
Category “B” x-ref not on EC CATEGORY file (#726)
Diag Code:  This is the primary Diagnosis Code value. It must exist on the ICD DIAGNOSIS file (#80). With functionality put in place by the Code Set Versioning project, only ICD codes that are active for the date and time of the event process are valid. The Diagnosis Code is only required for records sent to PCE. The system ignores it otherwise.
VistA messages
Diagnosis code is required for this DSS Unit
Unable to retrieve Diagnosis IEN
Assoc Clinic:  This is the Associated Clinic name. It must have a “B” cross-reference on the HOSPITAL LOCATION file (#44), be of type “C” (clinic), and be active for that encounter date. The Associated Clinic must have conforming stop codes to be selectable. The Associated Clinic is only required for records sent to PCE; otherwise, it will be ignored.
VistA messages
Associated Clinic is required for this DSS Unit
Assoc Clin “B” x-ref not found on HOSPITAL LOCATION file (#44)
Assoc Clin not found on HOSPITAL LOCATION file (#44)
Associated Clinic must be of type "C" (clinic)
Associated Clinic inactive for this encounter date
Modifier (1 through 5):  This is the Modifier, or Modifiers, associated with the procedure.
VistA message
Modifier is invalid or duplicated for the selected procedure
[bookmark: _Toc463463982]Service Connected Questions Validation
The Service Connected (SC) classification data validation and requirements are similar to those for records entered using other ECS data entry options. In order to assist the user in gathering SC information, Event Capture generates a spreadsheet of SC-related deficiencies found when transmitting the data. When a row fails validation because of SC-related deficiencies, an Export SC Errors button will appear above the Error Messages box. Click the button to generate an Excel spreadsheet, which the user can then save, print, or email to help resolve the errors.
[bookmark: _Toc463464101]Connected Error Message and Export SC Errors Button
[image: ]
[bookmark: _Toc463464102]Export SC Errors Spreadsheet
[image: ]
[bookmark: _Toc463463983]Other Error Correction Logic
DSS Unit IEN:  The system obtains the DSS Unit IEN by checking the DSS Unit IEN, the DSS Unit Number and the DSS Unit Name fields. If any of the three contain erroneous data, an error message is displayed and the record is not filed.
Send to PCE:  Using the DSS Unit, the application determines if the record transmits to PCE. If the DSS Unit is set to send to PCE, the application then validates the Associated Clinic and Diagnosis Code. If the DSS Unit is not set to send to PCE, the system ignores these two columns.
[bookmark: _Toc463463984]Duplicate Record Errors
If the system detects duplicate records when the spreadsheet uploads, a File Duplicate Record(s) checkbox appears on the screen.  The duplicate records display in the Error Messages box. Checking the File Duplicate Record(s) box and retransmitting the spreadsheet files the duplicate records in the Event Capture Patient file (#721).
If the user-defined threshold of duplicate records is reached, a screen is displayed with the options to continue processing the records, change the threshold, or abort the upload.
[bookmark: _Toc463464103]Duplicate Record Threshold Reached Screen
[image: ]
Continue:  Resets the counter and resumes processing records.
Change:  Allows the user to change the duplicate record threshold.
This threshold can also be altered prior to starting the upload process by selecting the Change Duplicate Threshold option from the Spreadsheet Options menu.
Abort:  Terminates the upload process.
[bookmark: _Toc462236911][bookmark: _Toc462236916][bookmark: _Toc462236922][bookmark: _Toc462236924][bookmark: _Toc463463985]Import a State Home Spreadsheet
State Home facilities use Excel spreadsheets for tracking patient occupancy. The State Home spreadsheet template is available for download from the State Home website (http://nonvacare.hac.med.va.gov/programs/state-homes-tools.asp). Event Capture can directly import, and upload, the data from these spreadsheets.
Steps for importing a State Home Spreadsheet:
1. Click the Open a State Home Spreadsheet button [image: ], or select the Open State Home Spreadsheet option from the File menu. A standard Select File dialog will be displayed, allowing the user to select the State Home spreadsheet to be imported.
[bookmark: _Toc463464104]Select File Dialog - Open a State Home Spreadsheet
[image: ]
Note:
Multiple months of State Home data can be stored in a single spreadsheet by using tabbed worksheets to represent the various months.  Only the worksheet that was active when the spreadsheet was last saved will be imported.
Once the desired State Home spreadsheet is selected for import, click the Open button.
A screen prompting the user for more information, including Facility Type, Location, DSS Unit, Date and Provider(s), is displayed.
[bookmark: _Toc463464105]Additional Data Form for State Home Spreadsheet Import
  [image: ]
Notes:
All fields must contain data in order to import a State Home spreadsheet.
Click the Cancel button on this screen to abort the import process.
Click the OK button on this screen to continue with the import. The data are then imported into Event Capture, and will be displayed in the grid of the Spreadsheet Upload form.
[bookmark: _Toc463463986]Upload Completion
As records are processed, the uploaded rows will be cleared from the data grid, and a progress indicator will display the number of rows uploaded and the number records in error. When all rows have been uploaded, both the data grid and the Error Messages list will be clear of all records.
[bookmark: _Toc463464106]Spreadsheet Upload Progress Indicator
[image: ]
[bookmark: _Toc421025650][bookmark: _Toc422471275][bookmark: _Toc422471443][bookmark: _Toc463463987]Reports
The following subsections describe the reports available within Event Capture.
[bookmark: _Toc422471276][bookmark: _Toc422471444][bookmark: _Toc463463988]Reports Available to All Users
The following reports are available to all users (including ECMGR key holders):
DSS Unit Activity Report
DSS Unit Workload Report
ECS Records Failing Transmission to PCE Report
Event Capture Encounters Report
Ordering Section Summary Report 
Patient Summary Report
PCE Data Summary Report
Procedure Reasons Report
Provider Summary Report
Provider (1-7) Summary Report
[bookmark: _Toc422742782][bookmark: _Toc463464107]Report Selection Screen for All Users
[image: ]
[bookmark: _Toc422471277][bookmark: _Toc422471445][bookmark: _Toc463463989]DSS Unit Activity Report
The report can be sorted by patient, provider or SSN.
If more than one location has been set up, choose one or all locations.
After previewing the report, the user will have the option to print or close the report.
1. Enter a date range.
Select one or all Location(s).
Select one or all DSS Unit(s).
Choose Sort Method (Patient, Provider or SSN) for the report.
Notes:
Only the last four digits of the patient’s SSN will appear on the print preview of this report.
The column order does not change with Sort Method when exported into Excel.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742783][bookmark: _Toc463464108]DSS Unit Activity Report Required Information
[image: ]
[bookmark: _Toc422742784][bookmark: _Toc463464109]DSS Unit Activity Report from Print Preview
[image: ]
[bookmark: _Toc422742785][bookmark: _Toc463464110]DSS Unit Activity Report from Export
[image: Screen Capture of the DSS Unit Activity Report exported version. ]
[bookmark: _Toc422471278][bookmark: _Toc422471446][bookmark: _Toc463463990]DSS Unit Workload Report
With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred
After previewing the report, the user will have the option to print or close the report.
1. Enter a date range.
Select one or all location(s).
Select one or all DSS Unit(s).
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742786][bookmark: _Toc463464111]Required Information for DSS Unit Workload Report
[image: ]
[bookmark: _Toc422742787][bookmark: _Toc463464112]DSS Unit Workload Report from Print Preview
[image: ]
[bookmark: _Toc422742788][bookmark: _Toc463464113]DSS Unit Workload Report from Export
[image: Sample DSS Unit Workload report that was exported to Excel.  This report contains location, DSS unit, category, CPT code, procedure code, procedure name, procedure volume, synonym,CPT modifer 1, Moifier 1 volume, CPT modifer 2, Moifier 2 volume, CPT modifer 3, Moifier 3 volume. ]
[bookmark: _Toc421025654][bookmark: _Toc422471279][bookmark: _Toc422471447][bookmark: _Toc463463991]ECS Records Failing Transmission to PCE Report
Locations, DSS Units, procedures, five-character EC National Codes (when applicable) and categories must be defined before using this option.
After previewing the report, the user has the option to print or close the report.
1. Select the date range.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742789][bookmark: _Toc463464114]ECS Records Failing Transmission to PCE Report Required Fields
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[bookmark: _Toc455135750][bookmark: _Toc422742790][bookmark: _Toc463464115]ECS Records Failing Transmission to PCE Report from Print Preview
[image: ]
[bookmark: _Toc422742791][bookmark: _Toc463464116]ECS Records Failing Transmission to PCE Report from Export
[image: The export sample of the ECS Records Failing Transmission to PCE Report contains the following columns with sample data: Date/Time, location, DSS Unit, Category, patient, SSN, procedure code, procedure name, provider 1, provider 2, provider 3, provider 4, provider 5, provider 6, provider 7, reason 1, reason 2, reason 3.]
[bookmark: _Toc422471280][bookmark: _Toc422471448][bookmark: _Toc463463992]Event Capture Encounters Report
Displays and counts the unique occurrences by patient and DSS Unit during a selected date range. It also enables sorting by patient or by provider.
When sorted by Patient shows the number of unique occurrences for the Patient across the date range that is selected. 
When sorted by Provider shows the number of unique occurrences for the Provider across the date range that is selected.
Includes the fields Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), Date/Time, Provider #1, DSS Unit and Volume.
After previewing the report, the user has the option to print or close the report.
1. Select a date range.
Select a Location.
Select one, all or multiple DSS Unit(s).
Select Sort Method (Patient or Provider).
Export, Preview, Print or Cancel the report.
Notes:
Only the last four digits of the patient’s SSN will appear on the print preview of this report.
The column order does not change with Sort Method when exported into Excel.
A report timeout warning and a message dialog are displayed when All Locations, All DSS units or large date ranges are selected. 
[bookmark: _Toc422742792][bookmark: _Toc463464117]Event Capture Encounters Report Required Fields
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[bookmark: _Toc422742793][bookmark: _Toc463464118]Event Capture Encounters Report Timeout Warning
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[bookmark: _Toc422742794][bookmark: _Toc463464119]Event Capture Encounters Report Sorted by Patient
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[bookmark: _Toc422742795][bookmark: _Toc463464120]Event Capture Encounters Report Sorted by Provider
[image: ]
[bookmark: _Toc422742796][bookmark: _Toc463464121]Event Capture Encounters Report from Export
[image: Screen Capture of the Event Capture Encounters Report export version. Columns Displayed: LOCATION, PATIENT, SSN, I/O, DATE/TIME, PROVIDER#1, DSS UNIT, VOLUME, CLINIC STOP CODE, CREDIT STOP CODE, CHAR4 CODE
]
[bookmark: _Toc422471281][bookmark: _Toc422471449][bookmark: _Toc463463993]Ordering Section Summary Report
The design of this report is for a 132-column format.
With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
After previewing the report, the user will have the option to print or close the report.
1. Enter a date range.
Select an Ordering Section.
Select a specific or all Location(s).
Select one, multiple, or all DSS Unit(s).
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742797][bookmark: _Toc463464122]Ordering Section Summary Report Required Information
[image: ]
[bookmark: _Toc422742798][bookmark: _Toc463464123]Ordering Section Summary Report from Print Preview
[image: ]
[bookmark: _Toc422742799][bookmark: _Toc463464124]Ordering Section Summary Report from Export
[image: Screen Capture of the Ordering Section Summary Report export version. Columns displayed are: Ordering Section, Location, DSS Unit, Patient, SSN, CPT Code, Procedure, Procedure Name, Synonym, Volume, Cpt Mod #1, Cpt Mod #2, Cpt Mod #2 and Providers 1-7.  ]
[bookmark: _Toc422471282][bookmark: _Toc422471450][bookmark: _Toc463463994]Patient Summary Report
The design of this report is for a 132-column format.
With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred. 
The user can choose to include Procedure Reasons (EVENT CAPTURE PATIENT file (#721)) on the report. Up to three reasons will be included.
The “Display Reasons on this report” will clear when the user selects another report or upon exiting the screen.
After previewing the report, the user will have the option to print or close the report.
1. Enter a date range.
Use the Patient Identifier field to select a patient.
Enter one of the following:
Patient Name (whole or partial, last name first)
Social Security Number
Last four digits of the Patient Social Security Number
First character of Last Name plus the last four digits of the SSN with no spaces
Press <Enter> on the keyboard or click the Search button. [image: Search button screen capture] 
Choose from the list of patients displayed.
Click the Display Reasons on this report checkbox to include Procedure Reasons in the report.
Export, Preview, Print or Cancel the report. 
[bookmark: _Toc422742800][bookmark: _Toc463464125]Patient Summary Report Required Information without Reasons
[image: ]
[bookmark: _Toc422742801][bookmark: _Toc463464126]Patient Summary Report from Report Preview without Reasons
[image: ]
[bookmark: _Toc422742802][bookmark: _Toc463464127]Patient Summary Report from Export without Reasons
[image: ]
[bookmark: _Toc422742803][bookmark: _Toc463464128]Patient Summary Report Required Information with Reasons 
[image: ]
[bookmark: _Toc422742804][bookmark: _Toc463464129]Patient Summary Report from Report Preview with Reasons
[image: ]
[bookmark: _Toc422742805][bookmark: _Toc463464130]Patient Summary Report from Export with Reasons
[bookmark: _Toc422471283][bookmark: _Toc422471451][image: ]
[bookmark: _Toc463463995]PCE Data Summary Report
The design of this report is for a 132-column format.
With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated descriptions are reflective of the date the event occurred. 
After previewing the report, the user has the option to print or close the report.
1. Enter a date range.
Use the Patient Identifier field to select a patient.
Enter one of the following:
Patient Name (whole or partial, last name first)
Social Security Number
Last four digits of the Patient Social Security Number
First character of Last Name plus the last four digits of the SSN with no spaces
Press <Enter> on the keyboard or click the Search button. [image: Search button screen capture] 
Choose from the list of patients displayed.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742806][bookmark: _Toc463464131]PCE Data Summary Report Required Information
[image: ]
[bookmark: _Toc422742807][bookmark: _Toc463464132]PCE Data Summary Report from Print Preview
[image: ]
[bookmark: _Toc422742808][bookmark: _Toc463464133]PCE Data Summary Report from Export
[image: PCE Data Summary Report example from Excel.  The columns are patient, procedure date/time, location, clinic, DSS ID, CPT code, procedure code, procedure name, procedure volume, CPT modifer 1, CPT modifer 2, CPT modifer 3, provider, primary diagnosis, 2nd diagnosis 1, 2nd diagnosis 2, 2nd diagnosis 3, 2nd diagnosis 4.]
[bookmark: _Toc422471284][bookmark: _Toc422471452][bookmark: _Toc463463996]Procedure Reasons Report
Locations, DSS Units, procedures, and procedure reasons must be defined before using this option.
With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated descriptions are reflective of the date the event occurred.
After previewing the report, the user has the option to print or close the report.
This report is exportable into an Excel spreadsheet. The tab in Excel is titled “Reasons” followed by the Date Range the user selected.
1. Select a date range.
Select one, all or multiple Location(s).
Select one, all or multiple Procedure Reasons.
Select one, all or multiple DSS Unit(s).
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742809][bookmark: _Toc463464134]Procedure Reasons Report Required Information
[image: ]
[bookmark: _Toc422742810][bookmark: _Toc463464135]Procedure Reasons Report from Print Reviews
[image: ]
[bookmark: _Toc422742811][bookmark: _Toc463464136]Procedure Reasons Report from Export
[image: Screen Capture of the Procedure Reasons Report export version. The columns displayed are Location, DSS Unit IEN, Reason Text, Reason #, Proc Code, Procedure Name, SSN, Patient, Date/Time and Provider. ]
[bookmark: _Toc422471285][bookmark: _Toc422471453][bookmark: _Toc463463997]Provider Summary Report
Locations, DSS Units, categories, procedures and procedure reasons must be defined before generating this report.
If Procedure Reason #1 is not listed, the report prints “Reason Not Defined”.
With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
After previewing the report, the user will have the option to print or close the report.
1. Enter a date range.
Select one or all Location(s).
Select one or all DSS Unit(s). 
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742812][bookmark: _Toc463464137]Provider Summary Report Required Information
[image: ]
[bookmark: _Toc422742813][bookmark: _Toc463464138]Provider Summary Report from Print Preview
[image: ]
[bookmark: _Toc422742814][bookmark: _Toc463464139]Provider Summary Report from Export
[image: An Excel exported example of the Provider Summary Report that includes columns for location, DSS Unit, Category, Provider, Procedure Code, Procedure Name, Procedure Reason #1, Procedure/Reason, CPT Modifer 1, CPT Modifier 1 volume, CPT Modifer 2, CPT Modifier 2 volume, CPT Modifer 3, CPT Modifier 3 volume.]
[bookmark: _Toc422471286][bookmark: _Toc422471454][bookmark: _Toc463463998]Provider (1-7) Summary Report
The design of this report is for a 132-column format.
With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
This report provides the ability to view up to seven provider numbers for providers within a Location/DSS Unit.
Summarizes the workload of providers for a selected date showing how many times a specific procedure was performed on a patient with the selected provider as Provider 1, Provider 2, through Provider 7.
After previewing the report, the user has the option to print or close the report.
1. Enter a date range.
Enter the name of a Provider.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742815][bookmark: _Toc463464140]Provider (1-7) Summary Report Required Information
[image: ]
[bookmark: _Toc422742816][bookmark: _Toc463464141]Summary Report from Print Preview
[image: ]
[bookmark: _Toc422742817][bookmark: _Toc463464142]Provider (1-7) Summary Report from Export
[image: Screen Capture of the Provider 1-7 summary report export version. Columns displayed are Provider Name, Location, DSS Unit, CPT Code, CPT MOD #1-#3(vol), Procedure Code, Procedure Name, Patient, SSN and Total AS prov #1-#7. ]
[bookmark: _Toc455131599][bookmark: _Toc422471287][bookmark: _Toc422471455][bookmark: _Toc463463999]Reports Available to ECMGR Key Holders Only
The following reports are available only to ECMGR key holders:
Category Report
Disabled Category and Procedure Summary
DSS Units with any Associated Stop Code Errors 
DSS Units/Event Code (EC) Screens for Selected Procedure Code Report
DSS Unit Users Access Report
Event Code Screens with CPT Codes Report
Event Code Screens with Inactive Default Associated Clinic
Inactive Person Class Report (IPC)
National / Local Procedure Codes with Inactive CPT Codes
National / Local Procedure Report
Print Category and Procedure Summary (Report)
Send No Records DSS Units Report
As shown in the figure below, ECMGR reports are displayed in the Select Report area, below the asterisk line.
[bookmark: _Toc422742818][bookmark: _Toc463464143]Report Selection Screen for ECMGR Key Holders
[image: ]
[bookmark: _Toc422471288][bookmark: _Toc422471456][bookmark: _Toc463464000]Category Report
Use the Category - Add or Update Categories option to create categories before selecting this report.
This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
After previewing the report, the user has the option to print or close the report.
1. Choose a status of Active, Inactive or Both.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742819][bookmark: _Toc463464144]Category Report Required Fields
[image: ]
[bookmark: _Toc422742820][bookmark: _Toc463464145]Category Report (Active) from Print Preview
[image: ]
[bookmark: _Toc422742821][bookmark: _Toc463464146]Category Report (Active) from Export
[image: The example Category Report (Active) from Export lists the name for the categories.]
[bookmark: _Toc422742822][bookmark: _Toc463464147]Category Report (Inactive) from Print Preview
[image: ]
[bookmark: _Toc422742823][bookmark: _Toc463464148]Category Report (Inactive) from Export
[image: The example Category Report (Active) from Export lists the name for the categories and an inactive date.]
[bookmark: _Toc422742824][bookmark: _Toc463464149]Category Report (Both Active and Inactive) from Print Preview
[image: ]
[bookmark: _Toc422742825][bookmark: _Toc463464150]Category Report (Both Active and Inactive) from Export
[image: The example Category Report (Active) from Export lists the name for the categories and an inactive date.]
[bookmark: _Ref462224898][bookmark: _Ref462224908][bookmark: _Toc422471289][bookmark: _Toc422471457][bookmark: _Toc463464001]Disabled Category and Procedure Summary 
This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
This report provides a list of ECS categories that have been disabled for one or all DSS Units for a specified location.  Event Code Screens that are comprised of DSS Units that allow category use, and have Event Code Screens defined using the disabled category, will appear on this report.
The report provides the Location, Service, DSS Unit IEN and name, Send Status and DSS Dept.
The exported data will include those fields listed above, as well as the DSS Unit Inactive, Disabled Category, CPT Code, Procedure Code, Procedure Name, Synonym, Clinic IEN, Clinic, Clinic Stop Code, Credit Stop Code and CHAR4 Code.
After previewing the report, the user has the option to print or close the report.
1. Select the report.
1. Select All Locations, One Location, or Multiple Locations. 
Export, Preview, Print or Cancel the report.
[bookmark: _Toc463464151]Disabled Category and Procedure Summary Required Fields
[image: ]
[bookmark: _Toc455135788][bookmark: _Toc463464152]Disabled Category and Procedure Summary
[image: ] 
[bookmark: _Toc463464153]Disabled Category and Procedure Summary from Export
[image: ]
[bookmark: _Toc463464002]DSS Units with Any Associated Stop Code Errors Report
This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
The Event Capture software restricts DSS-only workload to use valid Stop Codes. 
To assist sites in locating DSS Units that have invalid associated Stop Codes, the DSS Unit list with Secondary Associated Stop Codes option is provided. This may be attached as a secondary menu option and run as often as needed. The only prompt is for Device. 
This report provides a list of DSS Units with any error with the Associated Stop Code.
The report provides the DSS Unit IEN and name, Associated Stop Code IEN and name and the reason for the error.
After previewing the report, the user has the option to print or close the report.
Select an active non-secondary Stop Code to replace the Stop Code in the DSS Unit set up.
1. Select the report. 
Export, Preview, Print or Cancel the report.
[bookmark: _Toc455135791][bookmark: _Toc463464154]DSS Units with Any Associated Stop Code Errors Required Fields
[image: ]
[bookmark: _Toc455135793][bookmark: _Toc463464155]DSS Units with Any Associated Stop Code Errors
[image: ]
[bookmark: _Toc455135795][bookmark: _Toc422742828][bookmark: _Toc463464156]DSS Units with Any Associated Stop Code Errors from Export
[image: Sample of DSS Units with any Associated Stop Code Errors.  The report has columns for the DSS unit #, DSS unit name, stop code, stop code name, error#1, error#2, error#3.]
[bookmark: _Toc421025665][bookmark: _Toc422471290][bookmark: _Toc422471458][bookmark: _Toc463464003]DSS Units/Event Code (EC) Screens for Selected Procedure Code Report
Only holders of the ECMGR security key can run this report.
After previewing the report, the user has the option to print or close the report.
This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “Selected Procedure Code”.
1. Select one, all or multiple Location(s).
Select a Procedure.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742829][bookmark: _Toc463464157]DSS Units/Event Code (EC) Screens for Selected Procedure Code Report
[image: ] 
[bookmark: _Toc422742830][bookmark: _Toc463464158]DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from Print Preview
[image: ]
[bookmark: _Toc422742831][bookmark: _Toc463464159]DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from Export
[image: Screen Capture of DSS Units/Event Code (EC) Screens for Selected Procedure Code Report exported. Columns displayed:
PROCEDURE CODE, PROCEDURE NAME, DSS UNIT lEN, DSS UNIT, LOCATION, CATEGORY, EC SCREEN STATUS.]
[bookmark: _Toc422471291][bookmark: _Toc422471459][bookmark: _Toc463464004]DSS Unit User Access Report
This report is also accessible from the Grant Users Access menu option.
After previewing the report, the user has the option to print or close the report.
This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “DSS Unit User Access Report”.
1. Select a Location.
Select one, all or multiple DSS Units.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742832][bookmark: _Toc463464160]DSS Unit User Access Report Required Fields
[image: ] 
[bookmark: _Toc422742833][bookmark: _Toc463464161]DSS Unit User Access Report from Print Preview
 [image: ]
[bookmark: _Toc422742834][bookmark: _Toc463464162]DSS Unit User Access Report from Export
[image: Screen capture of the DSS Unit User Access Report that was exported into Excel.  The fields included in this report are DSS Unit, User Name, IEN and Person Class/Classification.]
[bookmark: _Toc422471292][bookmark: _Toc422471460][bookmark: _Toc463464005]Event Code Screens with CPT Codes Report
Users can print, preview or export Event Code Screens with active and/or inactive CPT codes for one or all DSS Unit(s). 
For previewing or printing the report, when Both is selected for Active and Inactive CPT codes, all inactive CPT codes are flagged with an *I* indicator.
For exporting the report, all Inactive CPT codes are flagged with an **Inactive** indicator.
[bookmark: p114_100][bookmark: Mgmnt_Security_Key]Users must have the Management Security ECMGR key to access this report.
After previewing the report, the user has the option to print or close the report.
1. Select one or all Location(s).
Select one or all DSS Unit(s).
Note:
If All is selected for the DSS Unit, the Category will also be All and will be disabled.
Select a Category.
Note: 
Categories only appear if the Event Code Screen uses categories to group procedures.
Select Active, Inactive or Both (Active and Inactive) for CPT Codes.
Export, Preview, Print or Cancel the report.
Note: 
[bookmark: _Toc422742835]The tab of the report indicates whether the exported report shows only active, only inactive, or both active and inactive CPT codes.
[bookmark: _Toc463464163]Event Code Screens with CPT Codes Report Required Fields
[image: ] 
[bookmark: _Toc422742836][bookmark: _Toc463464164]Event Code Screens with CPT Codes Report from Print Preview 
(Both Active and Inactive CPT Codes Selected)
[image: ]
[bookmark: _Toc422742837][bookmark: _Toc463464165]Event Code Screens with CPT Codes Report from Export
[image: Screen capture from export with only inactive CPT codes.  The fields listed in the report include Location, DSS Unit, Category, Procedure, National Number and CPT.]
The tab of the report above indicates that the report is “Showing only Inactive CPT Codes”.
[bookmark: _Toc422471293][bookmark: _Toc422471461][bookmark: _Toc463464006]Event Code Screens with Inactive Default Associated Clinic Report
Only holders of the ECMGR security key can run this report.
After previewing the report, the user has the option to print or close the report.
This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “Inactive Default Clinic”.
1. Select one, all or multiple Location(s).
Select one, all or multiple DSS Unit(s).
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742838][bookmark: _Toc463464166]Event Code Screens with Inactive Default Associated Clinic
[image: ]
[bookmark: _Toc422742839][bookmark: _Toc463464167]Event Code Screens with Inactive Default Associated Clinic from Print Preview
[image: ]
[bookmark: _Toc422742840][bookmark: _Toc463464168]Event Code Screens with Inactive Default Associated Clinic from Export
[image: Screen capture from Event Code Screens with Inactive Default Associated Clinic export.  The fields included in this report are DSS Unit, Location, Category, Procedure Code, Inactive Clinic IEN and Inactive Clinic Name.]
[bookmark: _Toc422471294][bookmark: _Toc422471462][bookmark: _Toc463464007]Inactive Person Class Report (IPC) Report
This report shows providers who do not have a Person Class specified in the NEW PERSON file (#200) or who do not have an active Person Class in the NEW PERSON file (#200) for the date of the procedure.
After previewing the report, the user has the option to print or close the report.
1. Enter a date range.
Select Sort by Patient or Sort by Procedure.
Export, Preview, Print or Cancel the report.
Note: 
[bookmark: _Toc422742841]The column order does not change with Sort Method when exported into Excel.
[bookmark: _Toc463464169]Inactive Person Class Report Required Information
[image: ]
[bookmark: _Toc422742842][bookmark: _Toc463464170]Inactive Person Class Report from Print Preview
 [image: ]
[bookmark: _Toc422742843][bookmark: _Toc463464171]Inactive Person Class Report from Export
[image: The Inactive Person Class Report (IPC) example exported from Excel.  The columns are patient name, SSN, procedure date, provider name, provider IEN# and error. ]
[bookmark: _Toc422471295][bookmark: _Toc422471463][bookmark: _Toc463464008]National/Local Procedure Codes with Inactive CPT Codes Report
This report provides a list of National and Local Procedure Codes with inactive CPT codes from EC NATIONAL PROCEDURE file (#725).
Users must have the Management Security ECMGR key to access this report.
After previewing the report, the user has the option to print or close the report.
1. Select the report. 
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742844][bookmark: _Toc463464172]National/Local Procedure Codes with Inactive CPT Codes Requirements
[image: ]
[bookmark: _Toc422742845][bookmark: _Toc463464173]National/Local Procedure Codes with Inactive CPT Codes Report Print Preview
 [image: ]
[bookmark: _Toc422742846][bookmark: _Toc463464174]National/Local Procedure Codes with Inactive CPT Codes Report from Export
[image: Screen Capture of the National/Local Procedure Codes with Inactive CPT Codes report export version. Columns displayed:
NATIONAL NUMBER, NATIONAL NAME, CPT CODE, INACTIVE DATE.]
[bookmark: _Toc422471296][bookmark: _Toc422471464][bookmark: _Toc463464009]National/Local Procedure Report – Active Procedures
Use the Procedure - Add or Update Local Procedures option to create local procedures before using this option.
This report is accessible to Management users only. For users without the Management Security key (ECMGR), this report will not appear. 
After previewing the report, the user has the option to print or close the report.
1. Click the Active button.
Choose a Preferred Report (National, Local or Both).
Choose the Sort Method (Procedure or National Code).
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742847][bookmark: _Toc463464175]National/Local Procedure Report (Active) Requirements
[image: ]
[bookmark: _Toc422742848][bookmark: _Toc463464176]National/Local Procedure Report (Active) from Print Preview
[image: ]
[bookmark: _Toc422742849][bookmark: _Toc463464177]National/Local Procedure Report (Active) from Export
[image: The National/Local Procedure Report (Active) sample from export includes columns for name, national number and CPT.]
[bookmark: _Toc422471297][bookmark: _Toc422471465][bookmark: _Toc463464010] National/Local Procedure Report – Inactive Procedures
Use the Procedure - Add or Update Local Procedures option to create local procedures before using this option.
This report is accessible to Management users only. For users without the Management Security key (ECMGR), this report will not appear. 
After previewing the report, the user has the option to print or close the report.
1. Click the Inactive button.
Export, Preview, Print or Cancel the report.
Note: 
If the report is marked as Inactive, the preferred report and sort method will be disabled.
[bookmark: _Toc422742850][bookmark: _Toc463464178]National/Local Procedure Report (Inactive) Required Fields
[image: ]
[bookmark: _Toc422742851][bookmark: _Toc463464179]National/Local Procedure Report (Inactive) from Print Preview
 [image: ]
[bookmark: _Toc422742852][bookmark: _Toc463464180]National/Local Procedure Report (Inactive) from Export
[image: The sample from the National/Local Procedure Report (Inactive) from Export shows the following columns: Name, National Number, CPT, Inactive Dates.]
[bookmark: _Toc422471298][bookmark: _Toc422471466][bookmark: _Toc463464011]Print Category and Procedure Summary (Report)
Use the DSS Unit - Add or Update DSS Units option to create DSS Units categories before using this option.
Use the Category - Add or Update Categories option to create categories before using this option.
Use the Procedure - Add or Update Local Procedures option to create procedures before using this option.
This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
After previewing the report, the user has the option to print or close the report.
1. Select one or all Location(s). 
Select one or all DSS Unit(s).
Note: 
If “All” is selected for the DSS Unit, the Category will also be “All” and will be disabled.
Select a Category.
Note: Categories only appears if the Event Code Screen uses categories to group procedures.
Select Active, Inactive or Both (Active and Inactive) EC Code Screens.
Export, Preview, Print or Cancel the report.
[bookmark: _Toc422742853][bookmark: _Toc463464181]Print Category and Procedure Summary (Report) Required Fields
[image: ]
[bookmark: _Toc422742854][bookmark: _Toc463464182]Print Category and Procedure Summary (Report) from Print Preview
[image: ]
[bookmark: _Toc422742855][bookmark: _Toc463464183]Print Category and Procedure Summary (Report) from Export
[image: Screen Capture of Print Category and Procedure Summary Report export version. Columns Displayed: EC SCREEN STATUS, LOCATION, SERVICE, DSS UNIT, DSS DEPT, SEND STATUS, DSS UNIT INACTIVE, CATEGORY, CPT CODE, PROCEDURE CODE, PROCEDURE NAME, SYNONYM, CLINIC , CLINIC IEN, STOP CODE, CREDIT STOP CODE, CHAR4 CODE.
]
[bookmark: _Toc421025673][bookmark: _Toc422471299][bookmark: _Toc422471467][bookmark: _Toc463464012]Send No Records DSS Units Report 
This report is accessible to Management users only. This report will not appear for users without the management security key (ECMGR).
Lists active DSS Units with send to PCE status of Send NO RECORDS.
Includes DSS Unit Name and IEN, Associated Stop Code (and Credit Stop and/or CHAR4 Code if present).
After previewing the report, the user has the option to print or close the report.
1. Export, Preview, Print or Cancel the report.
[bookmark: _Toc463464184]Send No Records DSS Units Report Required Fields
[image: ]
[bookmark: _Toc463464185]Send No Records DSS Units Report from Print Preview
[image: ]
[bookmark: _Toc463464186]Send No Records DSS Units Report from Export
[image: ]
[bookmark: _Toc455131601][bookmark: _Toc463464013]Management Menu 
The Event Capture Management Menu is available for users with the ECMGR security key. The main menu in the Management Menu provides the following management functions:
Location – Update Location Information
DSS Unit – Add or Update DSS Units
Access by User – Grant Access to DSS Units by User
Category – Add or Update Categories
Procedure – Add or Update Local Procedures
Reason – Add or Update Procedure Reasons
Event Code Screen – Add or Update Event Code Screens
Inactivate EC Screen – Identify/Inactivate Multiple Event Code Screens
[bookmark: _Toc422742856][bookmark: _Toc463464187]Event Capture Management Main Menu
 [image: ]
[bookmark: _Toc455131603][bookmark: _Toc421025674][bookmark: _Toc422471300][bookmark: _Toc422471468][bookmark: _Toc463464014]Location – Update Location Information
Before the User Starts
Location selected must be in the INSTITUTION file (#4).
Locations must be created with this option before the user can establish DSS Units. No further options are functional until the user creates an Event Capture location.
What the User Will See
Selecting the Location - Update Location Information option opens a screen that displays all the known location names, State, Facility Type, Station Number and Current Status in matrix form. The column width is adjustable.
From the first screen, double-click on a row or highlight a row and click the Update button.
[bookmark: _Toc422742857][bookmark: _Toc463464188]Management Menu (Locations) Screen
 [image: ]
After selecting a location, an edit screen will appear, allowing the user to create the location as a current Event Capture location, or to remove the selected location. 
[bookmark: _Toc422742858][bookmark: _Toc463464189]Edit Location Screen
 [image: ]
The rows can be sorted by using the Sort menu, or by clicking on the column header.
[bookmark: _Toc422742859][bookmark: _Toc463464190]Sort Menu Options
 [image: ]
To create a current location, click the checkbox labeled “Create as current Event Capture location” and click the OK button. The location is “flagged” as active for use in the Event Capture software. 
[bookmark: _Toc422742860][bookmark: _Toc463464191]Creating a Current Location
 [image: ]
To remove a current location, click the checkbox labeled “Remove as current Event Capture location” and click the OK button. The location is “flagged” as inactive for use in the Event Capture software.
[bookmark: _Toc422742861][bookmark: _Toc463464192]Removing a Current Location
 [image: ]
Click the Export button to export the Locations listing to Excel. The tab in Excel is titled “ECS Location Table Export.”
[bookmark: _Toc422742862][bookmark: _Toc463464193]ECS Location Table Export from Excel
 [image: ]
[bookmark: _Toc455131605][bookmark: _Toc421025675][bookmark: _Toc422471301][bookmark: _Toc422471469][bookmark: _Toc463464015]DSS Unit – Add or Update DSS Units
Before the User Starts
Use the Location - Update Location Information option to create an Event Capture location before using this option. 
A prompt displays a notification to enter an Associated Stop Code only if the "Send to PCE" flag is set to NO or NULL.
No further options are functional until DSS Units are created.
What the User Will See
After selecting DSS Unit from the Management Menu, the first screen will display a list of DSS Units. Click the Update button to update an existing DSS Unit or click the Add button to add a new DSS Unit.
[bookmark: _Toc422742863][bookmark: _Toc463464194]DSS Units Screen on Management Menu
 [image: ]
The DSS Units screen contains the following columns:
DSS Unit Name
Unit IEN
Active Status for DSS Unit (Yes or No) 
The PCE column reflects if workload is set to pass to PCE. Values include: 
ALL – Send all records
Outpatient – Send outpatient only
No – Send no records.
DSS Department
Service
Medical Specialty
Cost Center
Using the Find [image: Search googles screen capture] button, the user can search by DSS Unit, DSS Dept. and Unit IEN. Type in a partial search string, click Find and the screen will position to the first entry matching the search criteria.
The Print button enables users to print the report. 
The Export button enables users to export the data to an Excel spreadsheet.
[bookmark: _Toc422742864][bookmark: _Toc463464195]Report Exported into Excel
[image: Screen capture of the export into Excel.  The columns of this report are DSS Unit Names, Unit IEN, Active, PCE, DSS Department, Service, Medical Specialty and Cost Center.]
Click Update to update an existing DSS Unit or click Add to add new one. The Edit a DSS Unit or Add a DSS Unit screen will appear.
[bookmark: _Toc422742865][bookmark: _Toc463464196]Edit a DSS Unit Screen
[image: ]
Below are the element name and description for each field that appears on the Add or Edit DSS Unit screen: 
[bookmark: _Toc463464042]Table 2. Element Name and Description
	Element Name
	Description

	DSS Unit Name
	The name of the DSS Unit being created

	DSS Dept. and DSS Unit IEN
	The number to identify this DSS unit locally at the user’s site (1 to 14 characters) - The same DSS Unit number can be used for more than one DSS Unit 

	Service
	The service associated with this DSS Unit - from the SERVICE/SECTION file (#49)

	Medical Specialty
	The medical specialty associated with this DSS Unit - from the MEDICAL SPECIALTY file (#723)

	Cost Center
	The cost center associated with this DSS Unit - from the COST CENTER file (#420.1). Cost centers are defined in MP4-Part V, Appendix B of the Fiscal Service cost manuals.

	DSS Unit Status
	Active - Lists Active Event Code Screens
Inactive - Lists Inactive Event Code Screens 

	Event Code Screens
	Reactivate
Remain Inactive 

	Default Date / Time
	NOW – The current date and time will populate during data entry
NONE – No default date and time will be populated during data entry. The user is required to enter the date and time of the procedure.

	Allow Category Use
	YES – Use categories to group procedures during data entry 
NO – Do not use categories to group procedures during data entry

	Send to PCE
	Defines the method used to send the user’s data to PCE for the DSS Unit being created.
All Records - Send All Records
No Records - Send No Records

	Associated Stop Code
	Select the Stop Code associated with this DSS Unit. Be sure to select an active Stop Code. 

	Credit Stop Code
	Select the Credit Stop Code associated with this DSS Unit

	CHAR4 Code
	Select the CHAR4 Code associated with this DSS Unit



On add or edit screens, the status defaults to Active. The Allow Category Use field defaults to No, but the user can select Yes. The Send to PCE option can be setup for No Records, and the Associated Stop Code field is enabled. A search for the Associated Stop Code can occur by description or code, resulting in both the description and the code displaying. When Send to PCE is set to All Records, the Associated Stop Code field will not be visible. All other default options can be changed.
[bookmark: _Toc422471302][bookmark: _Toc422471470][bookmark: _Toc463464016]Add a DSS Unit
1. Click on the Add button. 
Enter a DSS Unit Name. 
Enter a DSS Dept 
Select a Service from the list provided. 
Select a Medical Specialty from the list provided. 
Select a Cost Center from the list provided.
Select the DSS Unit Status
Choose the Date / Time Default.
Choose whether or not to Allow Category Use.
Choose which records will be sent to PCE.
Click the OK button when selections are complete.
[bookmark: _Toc422471303][bookmark: _Toc422471471][bookmark: _Toc463464017]Update a DSS Unit
1. Select a DSS Unit from the list of DSS Units and click the Update button.
The Edit DSS Unit screen will be displayed. On this screen, the DSS Unit Name, DSS Dept., Service, Medical Specialty, Cost Center, DSS Unit Status, Event Code Screens status, Default Date / Time, Send to PCE, Allow Category Use, Associated Stop Code, Credit Stop Code, and CHAR4 Code fields can be updated. 
Notes: 
DSS Unit Status may be Active or Inactive.
The Event Code Screens options are different when Inactive is chosen for DSS Status.
[bookmark: _Toc422742866][bookmark: _Toc463464197]Original Active/Inactive Status
[image: Example of DSS Unit Status radio buttons and Event Code Screens options.]
When the DSS Unit Status is changed, the Event Code Screens options also change.
[bookmark: _Toc422742867][bookmark: _Toc463464198]Change from Active to Inactive or Inactive to Active
[image: Example of DSS Unit Status radio buttons and Event Code Screens options.
Showing how Event Code Screens options change whrn DSS Unit is changes from  Active to Inactive.]
If the user selects Retain, the DSS Unit will remain active.
If the user selects Inactivate, the DSS Unit that was active will be inactivated. 
Once a DSS Unit is inactive, the user can activate the DSS Unit again by selecting Reactivate. 
If the user selects Remain Inactive, the DSS Unit will remain inactive.
Click the OK button when selections are complete.
[bookmark: _Toc422471304][bookmark: _Toc422471472][bookmark: _Toc463464018]To Grant Access to a DSS Unit
From the Add or Update DSS Units screens, the user has the option to give specific users access to the DSS Unit being added or edited.
1. Click on the Access button at the bottom of the Add or Edit DSS Unit screen. 
The Grant Access to DSS Unit Screen has Include and Exclude fields.
The user can type the starting characters of the last name in the upper portion of the Excluded list box, or simply scroll through the list to search for a last name. The Excluded list box contains the names of all active VistA users at the site.
The DSS manager grants access to a specific DSS unit by moving a user to the Included list box, either by highlighting a name in the Excluded list box and clicking the Include button, or by simply double-clicking the name in the Excluded list box. Access is denied by moving the user to the Excluded list box, either by highlighting a name in the Included list box and clicking the Exclude button, or by simply double-clicking the name in the Included list box . 
Clicking the Apply button will save the changes and allow the user to grant access to additional users; clicking the OK button will save the changes and return the user to the previous screen.
Note: 
The IEN and Person Class/Classification for a selected user appear below its associated Excluded or Included list box.
[bookmark: _Toc422742868][bookmark: _Toc463464199]Grant Access to DSS Unit Screen
[image: ]
Note: 
Information has been deleted intentionally to preserve privacy
[bookmark: _Toc455131607][bookmark: _Toc421025676][bookmark: _Toc422471305][bookmark: _Toc422471473][bookmark: _Toc463464019]To Disable Categories for a DSS Unit
1. Select a DSS Unit which allows categories from the list of DSS Units and click the Update button.
[bookmark: _Toc462237161][bookmark: _Toc463464200]Edit DSS Unit Screen Showing a DSS Unit Set to Allow Categories
[image: ]
The Edit DSS Unit screen will be displayed. In the Allow Category Use section, click the No radio button, then click the Ok button.
[bookmark: _Toc463464201]Allow Category Use Set to No
[image: ]
A warning pop up window appears stating that if you disable the categories for this DSS Unit, this setting cannot be re-instated.  Click Yes.
[bookmark: _Toc463464202]Disable Category Warning Pop Up Message
[image: ]
On the Edit DSS Unit screen, the Event Code Screens section shows “None” listed in the Categories column.  The Allow Category Use section is now disabled.
[bookmark: _Toc463464203]Edit DSS Unit Screen After Disabling Categories
[image: ]
Step 44.  Click Ok to return to the Management Menu [DSS Units] screen.
Note:
Once categories are disabled for a DSS Unit, any fields for entering category information for that DSS Unit will be disabled on all Event Capture screens
Once categories are disabled for a DSS Unit, any previously entered workload will remain available for viewing and editing
A report is available to Management users which lists all DSS Units that have changed from Allowed to Disabled Categories. (See Section 4.3.2.2)
[bookmark: _Toc463464020]Access by User - Grant Access to DSS Units by User
Before the User Starts
Use extreme caution when utilizing this option. Removing access to a specified DSS Unit for all users and inactivating the DSS Unit is not recommended without the permission of the associated service.
Contact each service for a list of its Event Capture users and the DSS Units for which they enter data.
The user must have access to a given DSS Unit before procedure data can be entered.
Access can be provided to all DSS Units by assigning the ECALLU security key to a specified user (normally the DSS Manager or designee) using the Allocation of Security Keys option in the Key Management Menu under the Menu Management Menu. 
Note: 
This option cannot be used to remove access to DSS Units for users who hold the ECALLU security key.
[bookmark: _Toc463464021]To Assign User Access to DSS Units
1. Click on the Access by User - Grant Access to DSS Units by User button. 
When the screen opens, a list of users appears at the top of the box. Select a user.
[bookmark: _Toc422742869][bookmark: _Toc463464204]Grant Access to DSS Units by User
[image: ]
Select the names of the DSS Unit(s) by highlighting the particular unit and clicking on the Include button. 
[bookmark: _Toc422742870][bookmark: _Toc463464205]Grant Access to DSS Units by User
[image: ]
Click the Apply button to apply the changes and continue working, or click the OK button to apply the changes and exit the screen.
Note:
The user can print a list of users identified as having access to a given DSS Unit by clicking the Print button.
[bookmark: _Toc455131609][bookmark: _Toc421025677][bookmark: _Toc422471306][bookmark: _Toc422471474][bookmark: _Toc463464022]Category - Add or Update Categories
Before the User Starts
The user can ignore this option if the site’s DSS Units are defined for use without categories.
Categories cannot be deleted, but this option can be used to inactivate or reactivate them.
What the User Will See
After selecting Category – Add or Update Categories from the Management Menu, the first window displays a list of Category Names, the Date created, and the Inactivation Date.
[bookmark: _Toc422742871][bookmark: _Toc463464206]Categories Main Screen on Management Menu
[image: ]
The second screen enables the user to add a Category or to update a selected Category. The second screen contains fields called Category Name and Status.
[bookmark: _Toc463464023]To Add or Update Categories
1. To add a new local category:
Click the Add button on the screen, or click the Add menu item in the Edit menu. The Status field defaults to “Active”.
[bookmark: _Toc422742873][bookmark: _Toc463464207]Add Category Screen
[image: ]
Enter the name of the category to be added, then click the OK button.
To update an existing local category:
From the list of categories, select the category record to modify and click Update. The Update Category screen is displayed. 
Change the category to its new status by clicking Active or Inactive. Click the OK button to file the change and return to the previous screen.
[bookmark: _Toc422742874][bookmark: _Toc463464208]Update Category Screen
[image: ]
The Categories screen on the Management Menu will reflect the changes made.  If the category was inactivated, the Inactivation Date will display the current date.
The Export button enables users to export the data to an Excel spreadsheet.
[bookmark: _Toc422742875][bookmark: _Toc463464209]ECS Category Table Export from Excel
[image: Screen capture of the ECS Category Table that was exported to Excel.  The Columns on this report include Category Name, Create Date and Inactivation Date.]
[bookmark: _Toc455131611][bookmark: _Toc462236967][bookmark: _Toc462236971][bookmark: _Toc462236975][bookmark: _Toc462236981][bookmark: _Toc462236982][bookmark: _Toc421025678][bookmark: _Toc422471307][bookmark: _Toc422471475][bookmark: _Toc463464024]Procedure - Add or Update Local Procedures
Before the User Starts
Before using this option, print the National/Local Procedure Report from the Reports menu of the Event Capture Main Menu to print a list of procedures with their associated CPT codes. This report can be lengthy if it includes national procedures. This should be queued to print to a device during non-peak hours.
Enter an associated CPT code to pass local procedures to the PCE software.
A local procedure code number is required for any new local procedure. 
The local number code must be five characters in length, starting with an uppercase alpha character, followed by four alpha or numeric characters.
With functionality put in place by the Code Set Versioning project, only active CPT codes are made available, and are based on the date a local procedure is added.
What the User Will See
After selecting Procedure - Add or Update Local Procedures from the Management Menu, the first screen displays a list consisting of Procedure Name, Number, CPT Code and CPT Description, and Active status.
[bookmark: _Toc422742876][bookmark: _Toc463464210]Procedures Main Screen Management Menu
[image: ]
The detail screen enables the user to add a Local Procedure. This screen contains the following fields: Procedure Name, Procedure Number, CPT Code and Description, and Status. 
[bookmark: _Toc422742877][bookmark: _Toc463464211]Add Local Procedure
[image: ]
Local procedures cannot be deleted, but this option can be used to inactivate or reactivate them.
The CPT Code and Description field contains CPT Code look-up functionality. The user can search for an existing CPT Code by code, a portion of the code, or a part of the description. 
When attempting to file a new Local Procedure, the system compares the new procedure to the National Procedure code file to prevent duplication. A message is displayed, and the local procedure is not added.
Instructions to Add or Update Local Procedures
1. To add a new local procedure:
Click the Add button on the screen, or click the Add menu item in the Edit menu.
Enter the new local Procedure Name.
Enter the local Procedure Number.
Enter the CPT Code if the data will transmit to the PCE software.
Click the OK button. The new local procedure has been added.
[bookmark: _Toc422742879][bookmark: _Toc463464212]Adding a Local Procedure
[image: ]
[bookmark: _Toc422742880][bookmark: _Toc463464213]Update a Local Procedure
[image: ]
To update an existing local procedure:
Highlight the existing record and click the Update button, or double-click the row. 
Edit the Procedure Name, Procedure Number, CPT Code and Description, and/or Status.
Click the OK button. The local procedure has been updated.
[bookmark: _Toc422742881][bookmark: _Toc463464214]Editing a Local Procedure
[image: ]
[bookmark: _Toc422742882][bookmark: _Toc463464215]Update After Editing a Local Procedure
[image: ]
Click the Export button to export the Procedures listing to Excel; the tab in Excel is titled “ECS Procedure Table Export”.
[bookmark: _Toc422742883][bookmark: _Toc463464216]Export of Procedures into Excel
[image: Screen capture of the procedures that were exported into Excel.  The columns included Procedure Name, Number, CPT Code and Description and Active?.]
[bookmark: _Toc422471308][bookmark: _Toc422471476][bookmark: _Toc463464025]Reason - Add or Update Procedure Reasons
Before the User Starts
Users with the ECMGR security key can activate or inactivate existing reasons. If a reason is listed as inactive, it will not appear on the dropdown list for reasons on any screen.
Event Capture managers can add a new reason using the Event Capture – New Reason screen. 
What the User Will See
After selecting Reason – Add or Update Procedure Reasons from the Management Menu, the first screen displays a list of Active Reasons and Inactive Reasons.
[bookmark: _Toc422742884][bookmark: _Toc463464217]Management Menu (Reasons) Screen
[image: ]
[bookmark: _Toc463464026]Activate Reasons
Highlight one or more items from the Inactive Reasons list box and click the Activate button. To move more than one reason, click and hold the <Ctrl> key and then highlight additional items.
[bookmark: _Toc422742885][bookmark: _Toc463464218]Reasons Screen with Inactive Reasons Highlighted
[image: ]
The Inactive Reason(s) selected will appear in the Active Reasons column when the Activate button is clicked.
[bookmark: _Toc422742886][bookmark: _Toc463464219]Reasons Screen with Inactive Reasons Moved to the Active Column
[image: ]
Click the OK or Apply button to update the reason(s). A confirmation prompt will appear. Click the Yes button to save the changes. 
[bookmark: _Toc422742887][bookmark: _Toc463464220]Confirmation Prompt
[image: ]
[bookmark: _Toc463464027]Inactivate Reasons
1. Highlight item(s) from the Active Reasons list box and click the Inactivate button. 
To move more than one reason, click and hold the <Ctrl> key and then highlight additional items.
[bookmark: _Toc422742888][bookmark: _Toc463464221]Reasons Screen with Active Reasons Highlighted
[image: ]
The Active Reason(s) selected will appear in the Inactive Reasons column when the Inactivate button is clicked.
[bookmark: _Toc422742889][bookmark: _Toc463464222]Reasons Screen with Active Reasons Moved to the Inactive Column
 [image: ]
Click the OK or Apply button to update the reason(s). A confirmation prompt will appear. Click the Yes button to save the changes. 
[bookmark: _Toc422742890][bookmark: _Toc463464223]Confirmation Prompt
[image: ]
[bookmark: _Toc463464028]Add a New Reason
1. Click the Add button. The Event Capture – New Reason screen will appear.
[bookmark: _Toc422742891][bookmark: _Toc463464224]Event Capture – New Reason Screen
[image: ]
Type the value of the new reason. Click the OK button to add the reason to the Active Reasons column. Click the Cancel button to exit the screen without saving the record.
[bookmark: _Toc422742892][bookmark: _Toc463464225]Reasons Screen with New Reason Added
[image: ]
[bookmark: _Toc455131614][bookmark: _Toc421025680][bookmark: _Toc422471309][bookmark: _Toc422471477][bookmark: _Toc463464029]Event Code Screen:  Add, Update, or Copy Event Code Screens
Before the User Starts
Use the Location - Update Location Information option to create an Event Capture location before using this option. 
Use the DSS Unit - Add or Update DSS Units option to establish DSS Units before using this option.
Event Code screens must be defined before entering any Event Capture data.
A prompt for Category occurs only if the Event Code screen uses categories to group procedures.
The user must define an active Associated Clinic and CPT code to pass Event Code procedures to PCE. 
With functionality put in place by the Code Set Versioning project, only active CPT codes can be selected and they will be based on the date the event code screen is being set up. 
The Event Code screen enables the use of characters “/” and “-” in the search field.
The Associated Clinic on the Event Code screen is not auto-populated.
The Print and Export buttons have been added to the Event Code Screen.
Users with the ECMGR key will be able to copy EC screens to another DSS Unit 
What the User Will See
After selecting Event Code Screen - Add or Update Event Code Screens from the Management Menu, the first screen displays a dropdown box of DSS Units. 
Select a DSS Unit to display the Event Code Screen data.  Columns include Synonym, Procedure, Location, Default Associated Clinic, Category and Status. 
[bookmark: _Toc422742893][bookmark: _Toc463464226]Event Code Screens Example
[image: ]
The Event Code Table Report can be printed. When printing the report, the user will be prompted to choose Active, Inactive or All for the Clinic Status.
[bookmark: _Toc422742894][bookmark: _Toc463464227]Select Clinic Status for the Report
[image: ]
The Event Code Table Report can also be exported to Excel. The user will be prompted to choose Active, Inactive or All for the Clinic Status. The Excel spreadsheet columns included in this report are Synonym, Procedure, Location, Default Associated Clinic, Category and Status. The spreadsheet tab is “Event Code Table Export”.
[bookmark: _Toc422742895][bookmark: _Toc463464228]Exported Event Code Table Report
[image: ]
Highlight the Procedure and click the Update button. The Update Event Code Screen form contains the following fields:  DSS Unit, Category, Location, Procedure, Status, Procedure Synonym, Default Volume, Ask Reasons, and Default Associated Clinic.
[bookmark: _Toc422742896][bookmark: _Toc463464229]Update Event Code Screen Example
[image: ]
Select a Default Associated Clinic. The list box displays only active locations in the HOSPITAL LOCATION file (#44) whose type is “C” (clinic) and is a “count” clinic. In addition, if an Associated Clinic has non-conforming stop codes, the clinic will not be selectable. 
[bookmark: _Toc463464030]Setting a DSS Unit to Send Data to PCE
Instructions to add an Event Code Screen:
1. After selecting a DSS Unit from the dropdown box, click the Add button, or select the Add menu item from the Edit menu. 
At the appropriate dropdown boxes select the DSS Unit, Category (if enabled), Location (one/many/all), Procedure, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic. 
Click the OK button. 
[bookmark: _Toc455135867][bookmark: _Toc422742898][bookmark: _Toc463464230]Adding an Event Code Screen
[image: ]
To Update an Event Code Screen:
1. Click on an Event Code Screen from the list of Event Code Screens for the selected DSS Unit.
Click the Update button, or select the Update menu item from the Edit menu. 
Note: 
An error message appears if a user selects an Event Code Screen that has an inactive Associated Clinic.  The user has the option to select an appropriate active clinic or to leave the Associated Clinic blank.
[bookmark: _Toc422742899][bookmark: _Toc463464231]Invalid Associated Clinic Error
[image: ]
Update the Status, Procedure Synonym, Default Volume, Default Associated Clinic, and Ask Reasons. 
Click the OK button. 
[bookmark: _Toc422742900][bookmark: _Toc463464232]Update an Event Code Screen
[image: ]
Instructions to Copy EC Screens to another DSS Unit
1. Highlight a DSS Unit that has an Active status.
[bookmark: _Toc422742901][bookmark: _Toc463464233]Event Code Screen with Active DSS Unit Selected
[image: ]
Click the Edit menu and select the Copy EC Screens to another DSS Unit menu item.
[bookmark: _Toc422742902][bookmark: _Toc463464234]Copy EC Screens to Another DSS Unit on Edit Menu
[image: ]
The Select a target screen appears. Select a target DSS Unit (usually newly created) from the dropdown list, then click the OK button.
[bookmark: _Toc422742903][bookmark: _Toc463464235]Select a Target Screen
[image: ]
The Copy Event Capture Screen to <user-selected target DSS Unit> displays. 
The Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic fields can be modified on this screen.
The DSS Unit, Category, and Procedure cannot be edited.
Note: 
The target DSS Unit is usually newly created by the user, but an existing DSS Unit may also be used.
[bookmark: _Toc422742904][bookmark: _Toc463464236]Copy Event Code Screen
[image: ]
Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic can be modified on this screen. 
Note: 
If the DSS Unit is setup to not send records to PCE, the Default Associated Clinic is disabled.
One, many or all Event Code Screens can be copied.
To copy an Event Code Screen, review the field selections and make edits (if necessary). Click the OK button to save the changes, creating the copy.  The next Event Code Screen will appear.
To skip an Event Code Screen, click the Skip this EC Screen button. The next Event Code Screen will appear.
When all needed Event Code Screens are copied, select the Close button to return to the Event Code Screen. All of the previous changes will be saved.
Note: 
If the user does not select a Location when copying an Event Code Screen, the record will not be filed and the following two error messages will appear:
[bookmark: _Toc422742905][bookmark: _Toc463464237]Record Not Filed Error Message for Key Data Missing
 [image: ]  [image: ]
Click the OK button on each error dialog to return to the Copy Event Code Screens form and enter a Location.
[bookmark: _Toc455131616][bookmark: _Toc422471310][bookmark: _Toc422471478][bookmark: _Toc463464031]Inactivate EC Screen: Identify Inactive Multiple Event Code Screens
Before the User Starts
Users with the ECMGR security key can select an EC Product Code (CPT Code, National EC Procedure Code or Local EC Procedure Code) and then display all of the DSS Units using the selected Product Code on the Inactivate Selected Event Code (EC) Screens for Given Procedure Code form. 
Choose to inactivate Event Code Screens by utilizing the checkboxes in front of each entry. The user can display and print a list of Event Code Screens inactivated for a chosen EC Product Code.
What the User Will See
After clicking the Inactivate EC Screen button from the Management Menu, the Event Capture – Inactivate Selected Event Code (EC) Screens for Given Procedure Code form will be displayed.
Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local EC Procedure Code).  The associated DSS Units with IENs, Locations and Categories appear for the EC Product Code selected.
Checkboxes are available to the left of each entry. The user can select multiple checkboxes.
[bookmark: _Toc422742906][bookmark: _Toc463464238]Inactivate Selected Event Code (EC) Screens for Given Procedure Code
[image: ]
Instructions for Inactivating Event Code Screen(s)
1. Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local EC Procedure Code).
The list shows all currently active Event Capture Product Codes. Use the checkboxes on the left side of the screen to select entries to be inactivated.
[bookmark: _Toc422742907][bookmark: _Toc463464239]Entries Selected to be Inactivated
 [image: ]
Click the Apply or OK buttons to Inactivate. 
A confirmation message dialog will appear. Click the Yes button to inactivate the selection(s), or click the No button to return to the previous screen.
[bookmark: _Toc422742908][bookmark: _Toc463464240]Confirmation Message Dialog for Inactivate Event Code Screens
  [image: ]
If the Yes button is clicked in response to the confirmation prompt, a listing of the Event Code Screens that were inactivated will be displayed.
[bookmark: _Toc422742909][bookmark: _Toc463464241]Event Code Screens That Were Inactivated
 [image: ]
There will be an option to Print this list of inactivated screens or click the OK button to return to the previous screen.
To verify that the Event Code Screens are inactivated, reenter the Event Code Product Code that was previously used. The list of DSS Units, Locations and Categories does not include the inactivated Event Code Screens.
[bookmark: _Toc422742910][bookmark: _Toc463464242]Verifying that EC Screens were Inactivated
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[bookmark: _Toc463464032]Troubleshooting
[bookmark: _Toc463464033]Access Issues
Users need an Access Code and Verify Code obtained from their local Information Resource Management (IRM) staff to use the Event Capture GUI.
[bookmark: _Toc463464034]Log On Issues
Event Capture is usually accessed through a desktop shortcut which points to the installation location. Ask the local support staff for assistance. 
If Event Capture launches and then disappears or is not responding, make sure the listed IP address is correct and not blocked by firewall software for the system with which it is communicating. Local support staff is available to assist with issues.
[bookmark: _Toc463464035]GUI Appears Distorted
If the ECS GUI display appears to be missing scrollbars, columns or rows, ensure that the screen resolution is set to a resolution of 1440 x 900 or greater.
[bookmark: _Toc422471154][bookmark: _Toc422471322][bookmark: _Toc463464036]Example of Setting the Screen Resolution to 1600 x 900
1. Right-click on the desktop and select Screen resolution.
[bookmark: _Toc422742719][bookmark: _Toc463464243]Desktop Menu Displayed After Right Click
[image: Screen capture of changing a computer's screen resolution. The image is of right clicking on the desktop, and selecting the Screen Resolution option. ]
[bookmark: _Toc422742720][bookmark: _Toc463464244]Screen Resolution Display
[image: Screen Capture of Windows Change the appearance of your displays option, specifically the Resolution dropdown box. ]
 Select Normal size (1600 x 900) from the Resolution setting dropdown box and then click the OK or Apply button.
[bookmark: _Toc422742721][bookmark: _Toc463464245]Menu Displayed After Selecting Screen Resolution Button
(NVIDIA Graphics Card Menu)
[image: Screen Capture of Windows Change the appearance of your displays option, specifically the Resolution dropdown box being changed/selected to 1600x90. ]


[bookmark: _Toc463464037]Appendix A: Acronyms
	Acronym
	Description

	ADPAC
	Automatic Data Processing Application Coordinators

	CCOW
	Clinical Context Object Workgroup

	CHAR4
	A 4-character code value of the associated clinic as specified from the
DSS Clinics and Stop Code Worksheet File.

	CM
	Clinical Modification

	CPRS
	Computerized Patient Record System

	CPT
	Current Procedural Terminology

	CSV
	Code Set Versioning

	DIAG
	Diagnosis

	DOB
	Date of Birth

	DSS 
	Decision Support System 

	Dx
	Diagnosis

	EC
	Event Capture

	ECALLU
	Security Key - Event Capture All DSS Units

	ECMGR
	Security Key - Event Capture Manager

	ECNORPT
	Security Key - Event Capture No Reports

	ECPATIENT
	Event Capture Patient

	ECPROVIDER
	Event Capture Provider

	ECS
	Event Capture System

	ECSPSH
	Security Key - Event Capture Spreadsheet

	FAQ
	Frequently Asked Questions

	FY
	Fiscal Year

	GUI
	Graphical User Interface

	ICD
	International Classification of Diseases

	ID
	Identification

	IP
	Internet Protocol

	IPC
	Inactive Person Class 

	IRM
	Information Resource Management

	IT
	Information Technology

	MAS
	Medical Administration Service 

	MISC
	Miscellaneous

	N/A
	Not Applicable

	NPCD
	National Patient Care Database

	O&E
	Observation and Examination

	PCE
	Patient Care Encounter

	PIMS
	Patient Information Management System

	SHAD
	Shipboard Hazard and Defense

	SSN
	Social Security Number

	SW
	Southwest

	T&TC
	Section 508 Accessibility Testing and Training Center

	VA
	Veterans Affairs

	VAMC
	Veterans Affairs Medical Center

	VAMROC
	Veterans Affairs Medical and Regional Office Center

	VistA
	Veterans Health Information Systems and Technology Architecture
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[bookmark: _Toc463464038]Appendix B: Glossary
	Term
	Description

	Associated Stop Code
	The Stop Code that most closely represents the DSS Unit workload.

	Category
	Category provides Event Capture a common level to group associated procedures. Multiple procedures can be defined for each category.

	CCOW
	In the context of health informatics, CCOW is a Health Level-7 international standard protocol designed to enable disparate applications to synchronize in real time, and at the user interface level.

	CHAR4 Code
	A 4-character code value of the associated clinic as specified from the
DSS Clinics and Stop Code Worksheet File.

	Cost Center
	Cost Center reveals which service is using this DSS Unit. Cost Centers are defined in detail in MP4-Part V, Appendix B of the Fiscal service cost manuals.

	Conforming Clinics
	Clinics that have stop codes in compliance with their restriction types. Stop codes are used in accordance to their assigned restriction types. Stop codes with restriction type 'P' can only be used in the primary stop code position. Stop codes with restriction type 'S' can only be used in the secondary stop code position. Stop codes with restriction type 'E' can be used in either the primary or secondary stop code position.

	Count Clinic
	A clinic for which workload entered is credited.

	CPRS
	Acronym for Computerized Patient Record System

	CPT code
	CPT codes are published by the American Medical Association.  The purpose of the coding system is to provide uniform language that accurately describes medical, surgical, and diagnostic services.

	CPT Modifier
	CPT modifiers provide the ability to refine CPT procedure codes to better reflect procedures performed.

	CSV
	Code Set Versioning
The Health Information Portability and Accountability Act (HIPAA) mandated that applications using CPT codes, CPT modifiers, and diagnosis codes should allow users to select codes based upon a date that an event occurred. 

	DSS Unit
	A DSS (Decision Support System) Unit defines the lowest level segment used for tracking hospital resources. These units can be a small work unit within a service or a large division within a service. Management at each facility is responsible for tailoring the DSS Units to fit its resource/cost reporting.

	DSS Unit Number
	This code is used for additional identification of DSS Units.

	Event Capture
	Software designed to provide management tools necessary in tracking procedures not entered in other VistA packages.

	Event Code Screen
	Event Code Screens are unique combinations of location, DSS Unit, category, and procedure that define patient procedures.

	[bookmark: ICD10_Definition]ICD-10-CM
	International Classification of Diseases, Tenth Revision, Clinical Modification codes (based on the World Health Organization codes) 

	Location
	Initializing the user site as a location, the Event Capture software recognizes the user facility as a valid location to enter Event Capture data.

	MAS
	Acronym for Medical Administration Service, which is now Patient Information Management System (PIMS).

	Non-conforming Clinics
	Clinics with stop codes that do not comply with the assigned stop code restriction types of P=Primary, S=Secondary and E=Either.

	Non-count Clinic
	A clinic for which there is no workload credited.

	Ordering Section
	The medical section ordering the patient’s procedure.

	Parent Service
	The controlling service for a DSS Unit.

	PIMS
	Patient Information Management System, formerly Medical Administration Service (MAS).

	Procedure
	A specific function performed on, or service provided to, a patient. Multiple procedures can be associated with a single category.

	Procedure Reason
	A method of generically grouping patient procedures to further describe the event, often giving patient or provider information.

	Procedure Synonym
	See Synonym

	Provider
	The provider of care performing the procedure. This provider can be a doctor, nurse, technician, or any designated team of medical professionals.

	Reason
	See Procedure Reason

	Synonym
	A locally recognized name or description for a procedure

	T&TC
	Section 508 Accessibility Testing and Training Center

	Volume
	Volume is usually associated with the number of procedures performed. This field can also be used to track number of bed days, or to track time increments actually spent performing the procedure. (For example, if 15 minute increments is the unit, volume of 1 = 15 minutes, volume of 2 = 30 minutes, etc.)
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[bookmark: _Toc463464039]Appendix E: Other ECS Package Management Information
Set up an ECS mail group in VistA to receive relevant ECS notifications. Contact IT to set up a VistA ECS Mail Group so more than one person receives ECS administrative messages.
Examples of ECS package administrative Email messages:
When a new ECS patch is released
[image: Screen capture of an example of the email message a user could receive when a new ECS patch is released.]
[image: Screen capture of an example of the email message a user could receive when a new ECS patch is released.]
When an EC NATIONAL PROCEDURES file (#725) patch is loaded, a review of the EVENT CODE SCREENS file (#720.3) is performed. Event Code Screens, which have either inactive CPT or Event Capture Codes, or an Event Capture Code with an inactive “default” CPT code attached, are reported.
[image: Screen capture of an example of the email message a user could receive when new Event Code Screens are generated.]
Notes:
After a patch updating file #725:
Check for inactivated national EC Procedure Codes.
Check for Event Code Screens with out-of-date EC Procedure Codes.
When an ECS User is terminated
(May inactivate national EC Procedure Codes and report any Event Code Screens with out-of-date Procedure Codes.)
[image: Screen capture of an example of the email message a user could receive when an ECS User is terminated]
[image: Screen capture of an example of the email message a user could receive when an ECS User is terminated]
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[bookmark: _Toc463464040]Appendix F: Index
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Caveats and Exceptions	7
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Changing User ID and Password	7
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